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Foreword
Thank you for purchasing the Dagstation DX1000/DX1000N
(DX). This manual describes the basic functions and operating
procedures of the DX1000/DX1000N. To ensure correct use,
please read this manual thoroughly before operation. The following
five manuals are provided as DX1000/DX1000N manuals.
Paper Manual

Manual Title Manual No.

DX1000/DX1000N Operation Guide  IM 04L41B01-02E
This manual. It is also provided in the CD.

Control of Pollution Caused by the IM 04L41B01-91C
Product
Gives a description of pollution control.

Electronic Manuals Provided on the Accompanying CD

Manual Title Manual No.

DX1000/DX1000N Operation Guide  IM 04L41B01-02E
This is the electronic version of the paper manual.

DX1000/DX1000N User’s Manual IM 04L41B01-01E
Describes how to use the convenient functions of the
DX1000. Communication function is excluded.

DX1000/DX1000N/DX2000 IM 04L41B01-17E
Communication Interface User’s Manual
Describes how to use the communication functions using the
Ethernet and serial interfaces.

DAQSTANDARD User’s Manual IM 04L41B01-61E
Describes how to use the accompanying software program,
DAQSTANDARD.

Notes

» The contents of this manual are subject to change without prior
notice as a result of continuing improvements to the instrument’s
performance and functions.

» Every effort has been made in the preparation of this manual to
ensure the accuracy of its contents. However, should you have
any questions or find any errors, please contact your nearest
YOKOGAWA dealer.

« Copying or reproducing all or any part of the contents of this
manual without YOKOGAWA's permission is strictly prohibited.

* The TCP/IP software of this product and the document
concerning the TCP/IP software have been developed/created
by YOKOGAWA based on the BSD Networking Software,
Release 1 that has been licensed from the Regents of the
University of California.

Trademarks

« All the brands or names of Yokogawa Electric’s products used
in this manual are either trademarks or registered trademarks of
Yokogawa Electric Corporation.

* Microsoft, MS-DOS, Windows, Windows NT, and Windows XP
are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

» Adobe, Acrobat, and PostScript are trademarks of Adobe
Systems Incorporated (Adobe Systems).

» CompactFlash and CF are trademarks of SanDisk Corporation.

« For purposes of this manual, the TM and ® symbols do not
accompany their respective trademark names or registered
trademark names.

« Company and product names that appear in this manual are
trademarks or registered trademarks of their respective holders.

Revisions
1st Edition: December 2005
2nd Edition: October 2006
3rd Edition: April 2007

3rd Edition: April 2007 (YK)
All Right Reserved, Copyright © 2005, Yokogawa Electric Corporation

Safety Precautions

The DX conforms to IEC safety class | (provided with terminal for
protective grounding), Installation Category Il, and EN61326-1 (EMC
standard), class A (use in a commercial, industrial, or business
environment).

The DX is a measurement category Il (CAT Il) instrument.

* Measurement category Il (CAT II)

Applies to measuring circuits connected to low voltage
installation, and electrical instruments supplied with power from
fixed equipment such as electric switchboards.

The general safety precautions described here must be observed

during all phases of operation. If the DX is used in a manner not

described in this manual, the protection provided by the DX may be
impaired. Yokogawa Electric Corporation assumes no liability for
the customer’s failure to comply with these requirements.

Use the DX as a measurement category Il (CAT Il) instrument. The

DX is designed for indoor use.

About This Manual

» Please pass this manual to the end user. We also ask you to
store this manual in a safe place.

* Read this manual thoroughly and have a clear understanding of
the product before operation.

+ This manual explains the functions of the product. It does not
guarantee that the product will suit a particular purpose of the
user.

Precautions Related to the Protection, Safety, and Alteration of

the Product

The following safety symbols are used on the product and in this

manual.

“Handle with care.” To avoid injury and damage to

the instrument, the operator must refer to the

explanation in the manual.

Protective ground terminal

Functional ground terminal (do not use this terminal
as a protective ground terminal.)

Alternating current

10 =@ >

Direct current

ON (power)

OFF (power)

O

+ For the protection and safe use of the product and the system
in which this product is incorporated, be sure to follow the
instructions and precautions on safety that are stated in this
manual whenever you handle the product. Take special note
that if you handle the product in a manner that violates these
instructions, the protection functionality of the product may be
damaged or impaired. In such cases, YOKOGAWA does not
guarantee the quality, performance, function, and safety of
product.

» When installing protection and/or safety circuits such as lightning
protection devices and equipment for the product and control
system or designing or installing separate protection and/or
safety circuits for fool-proof design and fail-safe design of the
processes and lines that use the product and the control system,
the user should implement these using additional devices and
equipment.

 If you are replacing parts or consumable items of the product,
make sure to use parts specified by YOKOGAWA.

» This product is not designed or manufactured to be used in
critical applications that directly affect or threaten human lives.
Such applications include nuclear power equipment, devices
using radioactivity, railway facilities, aviation equipment, air
navigation facilities, aviation facilities, and medical equipment.
If so used, it is the user’s responsibility to include in the system
additional equipment and devices that ensure personnel safety.

» Do not modify this product.

IM 04L41B01-02E



WARNING

Use the Correct Power Supply

Ensure that the source voltage matches the voltage of the power
supply before turning ON the power. In the case of a desktop
type, ensure that it is within the maximum rated voltage range of
the provided power cord before connecting the power cord.

Use the Correct Power Cord and Plug (Desktop Type)

To prevent electric shock or fire, be sure to use the power cord
supplied by YOKOGAWA. The main power plug must be plugged
into an outlet with a protective earth terminal. Do not disable this
protection by using an extension cord without protective earth
grounding.

Connect the Protective Grounding Terminal

Make sure to connect the protective grounding to prevent
electric shock before turning ON the power.

The power cord that comes with the desktop type is a three-
prong type power cord. Connect the power cord to a properly
grounded three-prong outlet.

Do Not Impair the Protective Grounding

Never cut off the internal or external protective grounding wire or
disconnect the wiring of the protective grounding terminal. Doing
so invalidates the protective functions of the instrument and
poses a potential shock hazard.

Do Not Operate with Defective Protective Grounding

Do not operate the instrument if the protective grounding might
be defective. Also, make sure to check them before operation.
Do Not Operate in an Explosive Atmosphere

Do not operate the instrument in the presence of flammable
liquids or vapors. Operation in such an environment constitutes
a safety hazard.

Prolonged use in a highly dense corrosive gas (H2S, SOx, etc.)
will cause a malfunction.

Do Not Remove Covers

The cover should be removed by YOKOGAWA's qualified
personnel only. Opening the cover is dangerous, because some
areas inside the instrument have high voltages.

Ground the Instrument before Making External Connections
Connect the protective grounding before connecting to the item
under measurement or control unit.

Damage to the Protection

Operating the instrument in a manner not described in this
manual may damage the instrument’s protection.

Exemption from Responsibility

YOKOGAWA makes no warranties regarding the product except
those stated in the WARRANTY that is provided separately.
YOKOGAWA assumes no liability to any party for any loss

or damage, direct or indirect, caused by the user or any
unpredictable defect of the product.

Handling Precautions of the Software

YOKOGAWA makes no warranties regarding the software
accompanying this product except those stated in the
WARRANTY that is provided separately.

Use the software on a single PC.

You must purchase another copy of the software, if you are to
use the software on another PC.

Copying the software for any purposes other than backup is
strictly prohibited.

Please store the original media containing the software in a safe
place.

Reverse engineering, such as decompiling of the software, is
strictly prohibited.

No portion of the software supplied by YOKOGAWA may be
transferred, exchanged, or sublet or leased for use by any third
party without prior permission by YOKOGAWA.

Handling Precautions of the DX

Use care when cleaning the DX, especially any plastic parts.
When cleaning, wipe using a dry soft cloth. Do not use
chemicals such as benzene or thinner, since these may cause
discoloring and deformation.

Keep electrically charged objects away from the signal terminals.
If you do, the DX may malfunction.

Do not apply volatile chemicals to the display, panel keys, etc.
Do not allow rubber and vinyl products to remain in contact

with the DX for long periods of time. If you do, the DX may
malfunction.

When not in use, make sure to turn OFF the power switch.

If there are any symptoms of trouble such as strange odors or
smoke coming from the DX, immediately turn OFF the power
switch and the power supply source. Then, contact your nearest
YOKOGAWA dealer.

Handling Precautions of the External Storage
Medium (CF Card)

Use caution in the handling of the external storage medium as it
is a delicate product.

Write operation to storage media may fail under high-
temperature or low-temperature environments. If you are using
the DX in a low-temperature environment (around 10 °C or
less), use the DX after the warm-up time (at least 30 minutes)
has elapsed. If you are using the DX under a high-temperature
environment (around 40 °C or more), it is recommended that the
external storage medium be inserted into the drive when saving
the data and be removed after the data storage operation is
finished.

Remove the storage medium from the drive when turning the DX
ON/OFF.

Touching the compact flash section when static electricity is built
up on the human body can lead to erroneous operation.

For the general handling precautions of the external storage
medium, see the instruction manual that came with the external
storage medium.

CAUTION

Do not eject the external storage medium while the access
indicator is illuminated. This can damage the data.

Do not access the storage medium in a place with vibrations or
shock. The storage medium or drive may malfunction.

IM 04L41B01-02E



Checking the Contents of the Package
Unpack the box and check the contents before operating the
instrument. If some of the contents are not correct or missing or
if there is physical damage, contact the dealer from which you
purchased them.

DX

A name plate is located on the top panel of the DX (side panel on
models with the /H5[ ] option). Check that the model name and
suffix code given on the name plate match those on your order.

ame plate

NO. (Instrument Number)
When contacting the dealer from which you purchased the
instrument, please give them the instrument number.

MODEL and SUFFIX Code

Standard Accessories
The standard accessories below are supplied with the instrument.
Check that all contents are present and undamaged.

8. One of these power cord types is supplied according
to the instrument’s suffix code

No. Name Part Number/ Qty. Notes
Model

1 Terminal screws E9655FX 5 M4 (spares)

2 Mounting brackets B9900BX 2 For panel mounting
Except for the /H5[ ]
models.

3 Door lock key B8706FX 2 -

4 DAQSTANDARD DXA120 1 CD. Software for

for DXAdvanced setting the DX and

displaying data.

5 DX1000/DX1000N  IM04L41B01-02E 1 A4 size
Operation Guide (this
manual)
Control of Pollution  IM 04L41B01-91C 1
Caused by the

Model code | Suffix code Oggggal Description
DX1002 Dagstation DX1000 2ch, 125ms (25ms*12)
DX1004 Dagstation DX1000 4ch, 125ms (25ms”12)
DX1006 Dagstation DX1000 6ch, 1s (125ms*12)
DX1012 Dagstation DX1000 12ch, 1s (125ms*12)
DX1002N"11 Dagstation DX1000N 2ch, 125ms (25ms’12)
DX1004N"11 Dagstation DX1000N 4ch, 125ms (25ms*12)
DX1006N"11 Dagstation DX1000N 6ch, 1s (125ms*12)
DX1012N"11 Dagstation DX1000N 12ch, 1s (125ms*12)
Internal memory | -1 Standard Memory
-2 Large Memory
External storage medium| -4 CF card (with medium)
Language -2 English/German/French, deg F, and DST
version of DAQSTANDARD i

Options 1A1 Alarm output 2 points™

1A2 Alarm output 4 points™!

IA3 Alarm output 6 points™1*2

Ic2 RS-232 interface”

ICc3 RS-422A/485 interface"3

IF1 FAIL/Status output™

/H2 Clamped input terminal (detachable)

/H5[] | Desktop type™

M1 Matk ical functions

IN1 Cu10, Cu25 RTD input/3 leg isolated RTD

IN2 3 leg isolated RTD"S

IN3 Extended input type (PR40-20, JPt50, etc.)

/P1 24 VDCIAC power supply™

/R1 Remote control

ITPS2 | 24VDC transmitter power supply (2 loops)™®

ITPS4 | 24VDC transmitter power supply (4 loops)™?

/KB1 Easy text entry (with input terminal)"89

/KB2 Easy text entry (without input terminal)™8

/USB1 | USB interface

/PM1 Pulse input (including remote control and cal functions) 10

/IcC1 Calibration correction function

*1  |A1, /A2, |A3 cannot be specified together.

*2 /A3 and /F1 cannot be specified together.

*3 /C2 and /C3 cannot be specified together.

*4 [H5[|] can be specified for only DX1002, DX1004, DX1006, and DX1012.

D: Power cord UL, CSA st'd
F: Power cord VDE st'd

R: Power cord AS st’d

J: Power cord BS st’d

H: Power cord GB st’d
Null (/H5): Only for /P1 model (without power cord)
*5 IN2 can be specified for only DX1006, DX1006N, DX1012, and DX1012N.
*6 In case that /TPS2 is specified, /ITPS4, /A2, /A3, or [F1 cannot be specified
together.
*7 In case that /TPS4 is specified, /TPS2, /A1, /A2, IA3, or /[F1 cannot be
specified together.
*8 /KB1 and /KB2 cannot be specified together.
*9 In case that /KB1 is specified, remote input terminal (438227) is included.
*10 In case that /PM1 is specified, /A3, /M1, /R1, /TPS2, or /TPS4 cannot be
specified. And combination of /A2, /F1 cannot be specified together.
*11 DX1002N, DX1004N, DX1006N, and DX1012N are Pull Out Models.
*12 Values in parentheses are for the fast sampling mode.

Product
6 User’s Manuals B87062Z 1 CD. Contains the
for the DX1000/ PDF file of the user’s
DX1000N/DX2000 manual.
7 CF card B9968NM 1 32 MB (The size and
model may change.)
8 Power cord A1006WD 1 Supplied only for

models with the /H5D
option. Maximum
rated voltage: 125V
A1009WD 1 Supplied only for
models with the /H5F
option. Maximum
rated voltage: 250 V
A1024WD 1 Supplied only for
models with the /H5R
option. Maximum
rated voltage: 250 V
A1054WD 1 Supplied only for
models with the /H5J
option. Maximum
rated voltage: 250 V
A1064WD 1 Supplied only for
models with the /H5H
option. Maximum rate
dvoltage: 250 V
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No. Name Part Number/  Qty. Notes Protection of Environment
Model
9 Remote control 438227 1 Remote controller.
terminal Supplied only for
models with the /KB1 10
option. With two AA
alkaline batteries and

labels for the remote
control terminal.

Control of Pollution Caused by the Product

For details, see the Control of Pollution Caused by the Product
(IM04L41B01-91C).

Optional Accessories (Sold Separately)

The following optional accessories are available for purchase
separately. If you make an order, make sure that all contents

are present and undamaged. For information about ordering
accessories, contact the dealer from which you purchased the DX.

Proper Disposal of This Product
This is an explanation of how to dispose of this product based
on Waste Electrical and Electronic Equipment (WEEE), Directive
2002/96/EC. This directive is only valid in the EU.
» Marking

This product complies with the WEEE Directive (2002/96/EC)

No. Name Model Minimum  Notes ) .
aty marking requirement.
1 CF card 772091 1 128 MB The affixed product label (see below) indicates that you must not
772092 256 MB discard this electrical/electronic product in domestic household

772093 512 MB waste.
772094
2 CF card adapter 772090

1GB
Shunt resistor 415920 250 0 +0.1%
|

1
1
1
1
1
(for screw input terminal) 415921 1 100Q+01%
415922 1 10Q+0.1%
1
1
1
2
1
1

+ Product Category

4 Shunt resistor 438920 250 Q+0.1% . . . . .
(for clamped input 438921 100Q+01% With reference to the equipment types in the WEEE directive
terminal) 438922 100+0.1% Annex 1, this product is classified as a “Monitoring and Control
5 Mounting brackets B9900BX - instrumentation” product.
6 Door lock key B8706FX - Do not dispose in domestic household waste.
7 Remote control terminal 438227

Remote To return unwanted products, contact your local Yokogawa
controller. X
Europe B. V. office.

Style number, release number, and firmware

version number of the DX

Style number: This is the DX hardware number that is indicated
on the name plate.

Release number: This is the DX firmware number that is indicated
on the name plate. The number corresponds to
the integer part of the firmware version number.

Example: If the firmware version number is 2.01, the release

number is 2.

Firmware version number: This number is displayed on the DX
system information screen. For the procedure,
see section 2.5, “Viewing the DX Information”
in the DX1000/DX1000N User’s Manual (IM
04L41B01-01E).

— Release number
— Style number

6 IM 04L41B01-02E



Conventions Used in This Manual

* This manual covers information regarding DX1000/DX1000Ns
that have a suffix code for language “-2” (English).

« For details on how to set the language, see section 2.6,
“Changing the Language” in the DX71000/DX1000N User’s
Manual (IM 04L41B01-01E).

Unit
K: Denotes 1024. Example: 768 KB (file size)
k: Denotes 1000.

The following markings are used in this manual.

Improper handling or use can lead to injury to the user or damage
to the instrument. This symbol appears on the instrument to
indicate that the user must refer to the user’s manual for special
instructions. The same symbol appears in the corresponding place
in the user’s manual to identify those instructions. In the manual,
the symbol is used in conjunction with the word “WARNING” or

“CAUTION.”
WARNING

Calls attention to actions or conditions that could cause serious or
fatal injury to the user, and precautions that can be taken to prevent
such occurrences.

CAUTION

Calls attentions to actions or conditions that could cause light
injury to the user or damage to the instrument or user’s data, and
precautions that can be taken to prevent such occurrences.

Note
Calls attention to information that is important for proper operation
of the instrument.

Indicates after this mark reference to related procedure or
explanation.

Bold characters
Indicates character strings that appear on the screen and the
operation keys.

Opening the Electronic Manuals

The accompanying CD contains PDF files of the manuals. When
you load the CD into the CD-ROM drive on your PC, a startup
screen appears. Click the manual title to open the respective
manual.

If the startup screen does not appear, double-click DX_manual in
My Computer, and open the manuals in the English directory.

Revision History
The contents of this manual corresponds to the DX with release
number 2 and style number 2.

Edition| DX Addition and change to functions

2 Version |German, French, and Chinese can be selected
1.11 as display language.

Modbus client: 10 s, 20 s, and 30 s have been
added to the choices for the connection retry
interval.

24 VDC/AC power supply (/P1 option) have
been added.

Version |Tab key on the USB keyboard corresponds to
1.21 arrow keys (/USB1 option).

Requesting and releasing network information
are added.

Modbus client: Function to connect a server
with a unit number is changed.

Modbus client: Connection timeout value is
changed.

Modbus registers (floating point type for
communication input data) are added.

A data output format (Skip or OFF channel data
not output) is added.

Error messages 105, 221, and 222 are added.

Error messages 215, 218, 536 and 536 are
changed.

3 Release (Improvement to the operability on the historical
number |trend display.

2 Displaying the date in the grid time of the trend
display If the trend interval is set greater than

(Version .
or equal to 1 h/div.

2.0x
) Improvement to the display group setup

operation.

Addition of the Upper and Lower settings to the
bar graph base position.

Relay action when the alarm ACK operation is
executed has been added to the alarm output
relay settings.

Ability to reset the computed value during
computation (/M1 and /PM1 options).

Changes to how the data files are named.

Sorting the files by the update date/time.

Storage method for constantly retaining the
most recent data files in the CF card (Media
FIFO) has been added.

Progress display when saving all data of the
internal memory.

Changing the initial display selection menu.

Improvement to the data save operation to the
USB flash memery (/USB1 option).

Retaining the state of the “CapsLock” and
“NumLock” keys on the USB keyboard (/USB1
option).

Changing the default setting of the web server
function to “Use.”

Error messages, 513, 514, 515, and 516 have
been added.

Style The waterproof construction of the DX front
number |panel complies with the NEMA4 standard

2
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Introduction to Functions

Measured Items

You can connect DC voltage, thermocouple, RTD, and ON/OFF input and measure
various values such as temperature and flow rate. The DX samples the input signals at
the scan interval to obtain the measured values. The fastest scan interval is 25 ms on
the DX1002, DX1002N, DX1004, and DX1004N and 125 ms on the DX1006, DX1006N,
DX1012, and DX1012N.

Up to four alarm conditions can be set for each measurement channel.

Data Storage Function

Display Function

Other Functions

DAQSTANDARD

There are two methods of recording measured data. One is to record the measured data
continuously, and the other is to record only when certain events occur such as alarms.
The measured data is recorded to the internal memory at a specified interval. The data in
the internal memory can be stored to a CF card automatically or manually. By connecting
to a network via the Ethernet interface, the measured data can also be automatically
transferred to an FTP server on a network.

Automatic data transfer to an FTP server

Ethernet
DX Il—; E FTP server

/}ternal {emory CF card
AViad (e <

Measurement input

Measured data can be displayed as trends, numeric values, and bar graphs for each

group. In addition, the overview display can be used to display and monitor all channels

on a single screen.
Trend display

w |
o

. i Fhd i e
wa | HH § 132.74166.19)116.38 73.65 | T0.70 | 68.41

Computation Function (option) Various types of computation can be performed by
assigning equations to computation channels.

FAIL/status output function (option) Outputs an alarm when the DX fails. The function
also monitors the DX status such as the remaining
amount of internal memory and outputs alarms.

Remote control function (option) A specified action is executed when a remote input
signal is applied to the terminal on the rear panel.

Security function Enables only registered users can operate the
DX. The function can also be used to prohibit key
operation.

Communication function The Ethernet interface can be used to monitor the

DX using a Web browser and transmit e-mail when
an event occurs such as an alarm. In addition,
data of devices on the network can be loaded and
displayed using the Modbus protocol.

The accompanying software program, DAQSTANDARD, can be used to display the
measured data, convert the measured data format, and create DX setup data.

IM 04L41B01-02E



Introduction to Functions

DX System Configuration

The DX can be used to configure a system as shown below.
Referenced sections are of the DX71000/DX1000N User’s Manual.
Referenced pages are of this manual.

=]
[ — PC
 —
==
Ethernet B -
(Communication Interface User's Manual) I
| Temperature | Recorder PC
4 | controller
0 )
7 Serial communication* ‘V
N (Communication Interface
{< T_ Signal input » User's Manual)
P Sec. 3.3 -
] Ria)
Pulse input* » DX » @ CF card
P Sec. 3.10 P> Page 24
: USB flash memory
Transmitter power supply* @ « *
D Page 57 USB port P Sec. 2.12
= e Keys Keyboard
Alarm output® « D@ P Sec. 2.1
P Sec 3.5-3.8
Remote Terminal*
P Sec. 2.10
FAIL/status output* «
pSec. 2.9

Remote input*
P Sec. 7.1

*: Option

Terminology
* Memory sample

The operation of recording measured data.
* Memory start
The operation of starting the memory sample.
* Memory stop
The operation of stopping the memory sample.
* Display data
The waveform data shown on the DX display. The data recorded at the sampling
interval for the displayed data.
* Event data
Measured data recorded at a sampling interval separate from that of the display data.

IM 04L41B01-02E



Names of Parts

Front View
Key panel opened

YOKOGAWA ¢

LCD

Display various operation displays
such as the trend display as well as
setup displays.

Front cover (key panel)
Open the front cover by pulling the
: cover while holding down the tab at

i v o -1 the center of the upper section of the
[P — N
@
4

SAD cover.
2)

Power indicator

llluminates in red when the - R —
power is turned ON. llluminates @) CAUTION
in green when recording to the u = T
memory. ]] When closing the front cover, press
Remote control sensor the front cover in until the tab at the
(/KB1 and /KB2 options) < center of the upper section of the
. ) ) cover is all the way up. If the front
Receives infrared light from the Key panel cover cover is not closeg copmpletely the
remote control terminal. Open the cover by pinching the water and dust proof capability may
Label (front of the key panel cover) left tab and pulling forward. be impaired.
Write arbitrary labels for your
convenience.
Front cover opened
YOKOGAWA ¢
USB port CF card slot
A USB port conforming to Rev.
1.1.
J — CF card access indicator
Power switch o] A T— 8|~
Not available on the DX1002N, | | — e — ﬂ
DX1004N, DX1006N, and ‘: i - = e = CF card eject button
DX1012N. Used when ejecting the CF card.

Door lock key (included)
Insert the pin in the left hole to lock.
Insert the pin in the right hole to unlock.

10 IM 04L41B01-02E



Names of Parts

Rear Panel

Serial interface port

(/C3 option)

A RS-422A/485 interface

connector.

—— Power supply terminal and
USB port (/USB1 option) E— protective earth terminal.
A USB port conforming to Rev.
11 port coniorming fo Rev. — Serial interface port
o (/C2 option)
A RS-232 interface

Ethernet port connector.
A 10Base-T port.

&) @

e Optional terminals (/A[ ], /F1,
IR1, ITPS][ ], and /PM1 options)
Connect optional input/output

D —) signal wires.

©
@)
&

Input terminals (screw terminals
or clamped terminals (/H2 option))
Connect input signal wires from the
2 ' measured item.

Desktop Type (/H5[ ] Option)
Handle

Functional ground
terminal

Power
connector

L Feet and Stand

IM 04L41B01-02E 1"
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DX1000/DX1000N Workflow

When using the DX for the first time, carry out the following procedure.

Installation b

Environmental
Settings

Functional
Settings
Data
Management

Install the DX.
| 2 Page 48 and subsequent pages

Connect input/output wires to the terminals and connectors on the
rear panel, and connect the power cord.
> Page 51 and subsequent pages

Turn the power ON. (DX1002, DX1004, DX1006, and DX1012 Only)
P Page 14

Set the date/time, load the CF card, and so on.
P Page 19 and 24

Set measurement functions
P Page 20 and subsequent page, page 28 and subsequent pages

Start the measurement. Perform operations such as switching the
screen and writing messages. Save the measured data.
P Page 38 and subsequent pages

Check and manage the measured data.

Use the accompanying software program, DAQSTANDARD, to display
the measured data and convert the measured data to Excel, Lotus, and

ASCII formats.
» Page 47
» DAQSTANDARD User's manual (IM 04L41B01-61E)

IM 04L41B01-02E
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Turning the Power ON/OFF (px1002, Dx1004, DX1006, and DX1012 Only)

Turning the Power ON

A CAUTION

Before turning ON the power switch, check that

» The power cord/wires are connected correctly to the DX.

» The DX is connected to the correct power supply (see page 59).

If the input wires are connected in parallel with other devices, do not turn ON/OFF
the power switch of the DX or another device during operation. This can have
adverse effects on the measured values.

Open the operation cover.

2. Turn ON the power switch.
After performing a self-test for a few seconds, the operation screen appears.

3. Close the operation cover.

A CAUTION

« If nothing is displayed when the power switch is turned ON, turn OFF the
power switch and check the points listed above one more time. After checking
the points, turn ON the power switch again. If the DX still does not work, it is
probably a malfunction. Contact your nearest YOKOGAWA dealer for repairs.

» If an error message is displayed on the screen, take measures according to the
description in chapter 10, “Troubleshooting” in the DX71000/DX1000N User’s
Manual.

» Turn ON the power switch, let the DX warm up for at least 30 minutes, and then
start the measurements.

Turning the Power OFF

A CAUTION

Before turning OFF the power switch, check that the external storage medium is
not being accessed.

1. Open the operation cover.
2. Turn OFF the power switch.

3. Close the operation cover.

14 IM 04L41B01-02E



Basic Operation

Panel Keys

YOKOGAWA 4

® LCD

Key panel

DISP/ENTER key and four arrow
keys (up, down, left, and right)
Switches the operation screen.
Soft keys Selects and enters setup items.
f—%

Selects the menu that is displayed
at the bottom of the screen
A

OO0
@ @Emjamn@ie

DISP/ENTER key

Up arrow key

Right arrow key

Down arrow key
\T Left arrow key
START/STOP key Favorite key
Memory start/stop ESC key Displays the operation screen (up to eight
Cancels an screens) that are registered to the key
operation
USERkey — MENU key .
Executes the assigned Switches betwgen the operation
operation mode and setting mode
FUNC key

« Displays the soft key menu in operation mode
» Hold down this key at least 3 s in the setting mode to switch from the
setting mode to the basic setting mode

Status display section
Shows the display name, date/time, data recording, alarm icon, etc.

Imin/diy

 Data display section
Shows the measured data and the functional setup
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Basic Operation

Display on the Status Display Section

The following information is displayed in the status display section.
Memory sampling status

ras=] Data type
DISP: Display data
EVENT: Event data
Memory sampling progress

Memory sampling l
Displays the progress using a green bar graph. The frame indicates the file :

stopped

save interval (display data) or the data length (event data).
Error in internal memory.

m Contact your nearest YOKOGAWA dealer for repairs.

Displays the remaining memory sampling time for the left bar graph.

in progress E]

‘
i
i
i
i
i
: —
; Memory sampling ﬁ, A
i
i
i
} Memory sampling icon
i

Display name or group name

For all channel display on the trend display, “All” is
displayed.

Date and time

Displayed in yellow while the time is being corrected.

Batch name and the display
name are shown alternately.
Date and time

f If the “batch number-lot number” exceeds 20 characters,
' the “date and time” position is used to display the “batch
i number-lot number.”

When using the login function

Ydm i Name of the user logged in
ENER T IE- Date and time and the
display name are shown
alternately.

Fdm i nl

the login and batch functions

Name of the user logged in
Batch name, the display
name, and date and time are
shown alternately.

of CF card used. If Media FIFO* is not enabled

and the free space on the CF card falls below

10%, the level indicator changes to red.

* See section 1.4, in the DX1000/DX1000N User’s
Manual. Media FIFO is a function available on
release number 2 or later.

The green level display indicates the amount —— | E:

Alarm icon

Displayed when any alarm is activated.
Blinks when there are alarms that are

(Red) occurring but have not been acknowledged.

All alarms have been released after they
have occurred, but there are alarms that
(Green) have not been acknowledged.

— Status icon These icons are shown alternately

on models with /M1 option:

E Keys are locked.
E E-mail transmission is enabled.

The status assigned to the status output
relay (/F1 option) is occurring.

~ Computation icon (/M1 or /PM1 option)

White icon: Computation started

Yellow icon: Computation data dropout occurred

L—— CF card icon

)

CF card is being accessed.

Waiting.

#]| Light blue icon: CF card in the slot is not

recognized. Remove and reset it.

CF card error.

Carry out the procedure below to reset the CF

card icon to normal.

* Replace the CF card with a normal one.

» Format the CF card on the DX (the data on
the CF card will be erased).

16
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Basic Operation

Run Modes

Mode Transition Diagram

Power ON

|

Operation mode Setting mode

/ End menu > DISP/ENTER key

Basic setting mode

Basic Setting Hode

Saltinn mms |
AD. Hemorv
MENU key | U= Sefting menu i’ Basic seting
i displ Rapart displ
R Hold down the = st
T i iyl b e
MENU key | S5 : 3 seconds || e e’ )
or ESC key sl - Statis ralm
L L
[ [
DISP/ENTER MENU key DISP/ENTER
key or ESC key key ESC key

I o
Firat=ch: Wl Last-ch:
Range

aea  Setup display

1 [ore
2 [off

3 I\?ff
4 |off
M fnat 153 |

Basic Setting Hode

Sean intarusl

Scan wode Eg
Scan interval 1

MO integrate futs
Hemary N

bata kin{  Setup display

l:n’m-m-

The DX has three modes.

Mode Description
Operation mode A mode for performing measurements.
Setting mode A mode in which input range, measurement method, and so on

are configured. Settings can be changed when memory sample is
in progress excluding some items.

Basic setting mode A mode used to set basic items such as the scan interval and
storage format of measured data. You cannot switch to this mode
when memory sample is in progress.

* For further details on the basic setting mode and setting mode, see page 62.

Carry out the steps given in the following pages. It will help you to understand the DX
operation.
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Basic Operation

Entering Values and Characters
The character/number input window and DISP/ENTER key are used to set the date/time,

set the display span of the input range, set the tag, set the message string, enter the

password, etc.

Character/number input window

First-CcH

DISP/ENTER key and four arrow

Cursor

Taa

Text box for entering
the character string

Charac

Hemory ¢
Ondf0ff

Alarm de
Time

Select the character
(keypad)

E Left and right arrow soft keys

Input status of the A/a/1 soft key
Input status of the Ins soft key

When a window for entering a character string appears, enter it by performing the

following key operation.

» Left and right arrow soft keys: Moves the cursor in the text box to select the input

* Keypad:

* DISP/ENTER key:

* Bs soft key:
e Alal1 soft key:

position.
Use the four arrow keys (up, down, left, and right) to move the
cursor on the keypad to select the desired character.
Ins: Switches between insert and overwrite.
Del: Deletes the character at the cursor position in the text box.
ENT: Enters the character string in the text box.
Enter the character that you selected with the keypad in the text
box or execute Ins, Del, or ENT.
Backspace. Deletes the character before the cursor.
Selects uppercase alphabet (A), lowercase alphabet (a), or value
(1).
The character type that you can enter changes each time
you press the Alal1 soft key. The selected character type is
displayed at the bottom section of the character/number input
window.

18
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Basic Operation

Changing the Date/Time

In this example, we will change the date from the 1st to the 6th. After carrying out this
step, reset the time to the correct date/time.

1. Display the operation mode screen.
SR 12/01 03:55:03 VI (O]

2.
ting menu

Date/Tine m Select Date/Time
Heas channel Dawlight Saving Time
Hath channel »
Display »
Group zet, Trip line
Hessage
Timer, Event action »
Data save »
SavesLoad »

»

Hehu customize

3. Press DISP/ENTER once to open the Time set window.

4. Change the date from 01 to 06.
Select the input position: Press the right arrow soft key five times. Move the
cursor in the text box.

Select the value: Press the right arrow key six times. The cursor on the
keypad moves to 6.

Enter the value: Press DISP/ENTER once to enter 6.

Move to enter the input: Press the down arrow key once. The cursor on the
keypad moves to ENT.

Enter the input: Press DISP/ENTER once.

Cancel the setting: Press ESC before pressing DISP/ENTER (entering the
input).

@0 T (S)

11 16:
5/12/86 131:53 ° g Time

ENT

Display the Time set window
(Display after entering 6)

Save/Load }‘
Hehu customize »

5. Press ESC or MENU to return to the operation mode screen.

Operation complete.
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Basic Operation

Operation Example in the Setting Mode: Changing the Input Range
Set the input range of channel 2 to thermocouple type T and 0.0 to 400.0°C.

DX

Type T
thermocouple ~ Channel 2

<

0

1. Display the operation mode screen.

Press MENU once to display the setting menu.
3. Press the down arrow key once to select Meas channel.

4. Press the right arrow key once.

2

Date/Tine ¥

Select the Range, Alarm

Hath channel Taa, Hemory, Delay
Dizplay Hoving average

Group set, Trip 1i Colar

Hessage Zone, Scale

Timer, Event actic Bar graph

Data save Alarm mark

SavesLoad Color scale band

Henu customize Calibration correction

5. Press DISP/ENTER once.

@0 T (S)
First-CH: Last-CH: 1
Range (4 A
Hode Range Span_L Span_ll Select First-CH
[Wo1t [ 2y [-2.eeee [ 2.eee8

Press the 2 soft key once. The Last-CH is also set to 2.

7. Press the down arrow key once to move the cursor to Mode.
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Basic Operation

10.

12,

13.
14.

15.

16.

Press the TC soft key once. The cursor moves to Range, and the changed item is
displayed in yellow.

; S ()

First-CcH [27 Last-cH: [z
Range
Hode Range Span_L Span_ll

T?C a.8 [ 1768.8

Select TC

Press the Next soft key.

Press the T soft key once. The cursor moves to Span_L.

Display the Span_L setting window

Alarm

1 |off

2
3 0ff
4

Enter 0.0 in the Span Lower box.

Select the digit: Press the right arrow soft key once. Move the cursor in
the text box.

Press the down arrow key once. Press the right arrow
key once. The cursor on the keypad moves to Space.

Select the character:

Enter characters:
Move to enter the input:

Enter the input:

Cancel the setting:

Press DISP/ENTER three times.

Press the down arrow key once. The cursor on the
keypad moves to ENT.

Press DISP/ENTER once. Span_L is set, and the cursor
moves to Span_U.

Press ESC before pressing DISP/ENTER (entering the

input).
Press DISP/ENTER once. The cursor moves to Span_U.
Enter 400.0 in the Span Upper box.
See step 12 for the procedure.

Press DISP/ENTER once. The changed items are entered, and the cursor returns
to First-CH. The changed items change from yellow to white.

n Last-CH:

First-CcH: 2
Range
Hode Range Span_L  Span_U
[ Te [ 1 ] A.8 | 4B,
Alarm
[oFF
2 |0ff
3 |0ff
4 [off
1 20 |

Press ESC or MENU to return to the operation mode screen.

Operation complete.

IM 04L41B01-02E
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Basic Operation

Operation Example in the Basic Setting Mode: Changing the Scan Interval
In this example, we will change the scan interval. Here, the scan interval on the DX1012

is changed to 2 s. The selectable scan intervals are different on the model, but the
procedure is the same.

Measures every 2 s

Type T
thermocouple  Channel 2

<

1.

Iminddiy

ting menu

DatesTime .2
Heas channel »
Hath channel »
Display »
Group zet, Trip line
Hessage

Timer, Event action »
Data save »
SavesLoad »
Hehu customize »

3. Hold down FUNC for at least 3 s.

Basic Setting Hode

Setting menu #|— Display the Basic Setting Mode menu
| Alarn )
A/D, Hemory
Burnout, RJG
Erwei ronment »
Report »

Tine settings
Load settings, Initialize
Conmunication (Ethernety »
Communication Seriall »
Status relay

4. Press the down arrow key once to select A/ID, Memory.
5. Press DISP/ENTER once.

Basic Setting Hode

Scan interval

Sean mode | tornal |
Scan interval 1s
A/D intearate Auto
Hemory
Data kind Dizsplay

[ Normal | FAST |
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Basic Operation

6. Press the down arrow key once to move the cursor to Scan interval.

7. Press the 2s soft key once. The cursor moves to A/D integrate, and the changed
item is displayed in yellow.
Cancel the setting: Press ESC before pressing DISP/ENTER.

8. Press DISP/ENTER once. The changed items are entered, and the cursor returns
to Scan mode.

Basic Setting Hode

Scan interval

Scan mode

Scan interval 2z & ———— Setthe scanintervalto2s
A/D intearate Auto

Hemory

Data kind Display

Hormal

9. Press ESC once to return to the basic setting mode menu.
10. Press the up arrow key twice to move the cursor to End.
11. Press DISP/ENTER once.

Basic Setting Hode

Setting menu

A/D, Hemory
Burnout, RJG
Erwi ronment »

& — Display the confirmation window

[ cancel

12. Press DISP/ENTER once. The settings are saved, and the DX returns to the
operation mode screen.
Discard the changes: Select No and press DISP/ENTER.
Do not end the basic setting mode: Select Cancel and press DISP/ENTER.

Operation complete.

IM 04L41B01-02E
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Basic Operation

Inserting/Removing a CF Card

Inserting a CF Card
1. Open the operation cover.

A CAUTION

Forcing the CF card into the slot with
the upside down may cause damage.

With the label “This side up”
Qacing up

2. Insert the CF card into the slot.
: o 0= I (3]

Displays the CF card icon

Iminddiy

3. Close the operation cover.

Operation complete.

Removing a CF Card
<Operations in the Operation Mode>

1. Press FUNC once.
2. Press the Next soft key.

= = f
o= (D) CF card icon

Iminddiy

Media eject

3. Press the Media eject soft key once.

4. Press the CF soft key once. The message “Media can be removed safely”

appears. Displays the CF card icon in blue.

5. Open the operation cover.

24
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Basic Operation

6. Press the CF card eject button. When you eject the CF card, the storage media
icon disappears.

~

Press the eject button in until it clicks.

The eject button stops at depressed position.
Pinch the left and right sides of the CF card
and remove it.

Eject button

7. Close the operation cover.

Operation complete.

<Operation in the Basic Setting Mode>
1. Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), select Load settings, Initialize > Media eject > CF, and
press DISP/ENTER.

Basic Setting Hode

Setting menu

A/D, Hemory

Burnout, RJG

Erwei ronment »
Report »

Tine settings

Load settings
Initialize

Gommunication (Sedl] Select CF
Status relay
End

The message “Media can be removed safely” appears.

2. Open the operation cover.
3. Press the CF card eject button. Remove the CF card.

4. Close the operation cover.

Operation complete.

Note

If you remove the CF card without carrying out the media eject procedure, the message “Media
was removed compulsorily” appears. Remove the CF card by carrying out the procedure above
to prevent damaging the data that is stored.

IM 04L41B01-02E
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Basic Operation

Saving the Setup Data

In this example, we will save the setup data to a file named “SF2” on the CF card.

1.

9.

Display the operation mode screen.

[ = .
o S0 I (O

Iminddiy

A. ARAT v
Press MENU once to display the setting menu.
Press the up arrow key twice to select Save/Load.

Press the right arrow key once and down arrow key three times.

DatesTime »

Heas channel »

Hath channel »

Dizplaw »

Group =et, Trip 1i Load display data
Hessage Load event data

Timer, Event actic
Data save
¢ Load
Hehu customize

Load settings
Save settings
File list/delete
Format

Select Save settings

Press DISP/ENTER once.
Press the Input soft key once.

Enter “SF2” for the file name.
For the input procedure, see “Entering Values and Characters” on page 18.

; S ()

Press DISP/ENTER once. The message “Data are being saved to media”
appears, and the setup data is saved.

Press ESC or MENU to return to the operation mode screen.

Operation complete.

26
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Basic Operation

Loading the Setup Data

In this example, we will load the setup data “SF2” from the CF card and update the DX
settings.

Here, only the setup data of the setting mode is loaded. To load the setup data of both
the setting mode and basic setting mode, press MENU, hold down FUNC for 3 s, select
Load settings, Initialize > Load settings, and press DISP/ENTER.

1. Display the operation mode screen.
=1
g RedDIF @]

Iminddiy

. AR v

2. Press MENU once to display the setting menu.

3. Press the up arrow key twice to select Save/Load.

DatesTime »

Heas channel »

Hath channel »

Display »

Group =et, Trip 1i Load display data
Hessage Load event data

Timer, Event actic
Data save Save settings
oad File list/delete

Hehu customize Format

Select Load settings

5. Press DISP/ENTER once to select the root directory (CF:/).
6. Press DISP/ENTER once to display the files in the root directory.

7. Select the file SF2.PDL using the up and down arrow keys.
- [T Eﬁ?tm}.llnﬂiﬂl[:j

oad zettings

fF:/

POL

File name

Free space 25497 Kbwtes

To move to a lower directory
Select the directory, and press
DISP/ENTER

To move to a higher directory
Press ESC

8. Press DISP/ENTER once. The message “File is being loaded from media”
appears, and the setup data is loaded. The DX automatically returns to the

operation mode screen.

Operation complete.
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Setting the Input Range and Alarm

Setup Example 1: Temperature Measurement Channel

DX
\ \

Type T
thermocouple Channel 1

<
0.0 to 200.0°C 0
Setup Item Description Number in the Figure
Channel Use channel 1. 1
Tag TI-001 2
Sensor Type T thermocouple 3
Input range 0.0 to 200.0°C 4

(1) Input Range
Press MENU (switch to the setting mode)

Last-CH: 1
Range—Span_t Span_t T 1
[ 1 ] A.8 | 208.8
1oLt \
3
(2) Tag
From the setting menu, select: Meas Channel > Tag, Memory, Delay
3 [ =1
9.3 e IEET(O)
Last-CH: 1
Tasg
Characters TI-8A1 ————2
Hemory sample
On/0ff On
Alarm delaw
Time 18 =

Operation complete.
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Setting the Input Range and Alarm

Setup Example 2: Flow Rate Measurement Channel and Alarm
DX

Flowmeter Channel 2

4-20mA
o:®: /D

Convert to 1-5 V with a shunt resistor

Setup Item Description Number in the Figure
Channel Use channel 2. 1
Tag F1-002 2
Input signal 1-5V 3
Input range 0.0 to 500.0 L/H 4
Alarm condition Output an alarm if the measured valueis 5

less than or equal to 120.0 L/H.
Output destination: Relay contact (103)

(1) Input Range and Alarm
Press MENU (switch to the setting mode)

From the setting menu, select: Meas Channel > Range, Alarm

1 16:d
First-CH: ? Last-CH: l?

Range

Hode Range Span_L Span_ll 1
[1-5v |1—$u [ 1.ees [ 5. e8@

Scale_| Scalelll  Unit Low-cut 3
[ a8 | 508.8 [L/H 0ff

Hlarnl Fype— Watue Retay—to- 4
1 [on T 12%.3 of 1%3

2 [off

3 [ofr 5
4 [off

(2) Tag

Tag

Characters FI-8@2 ———2
Hemory sample

On/fOff On

Alarm delay

Time 18 =

Operation complete.
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Setting the Display

Setup Example 3: Assigning Channels to Groups

In this example, we will assign channels 1 and 2 to group 1.

F1-B@2
187.9 425.0
(N L/H
Channel 1 Channel 2
Setup Item Description Number in the Figure
Group Assign channel 1 and 2 to group 1. 1
(1) Group

MENU key (switch to the setting mode) and select Group set, Trip line
oot 1301 15:44:24 o= MY (O 0}
Group number 1

Group set
Ons0ff 0n @
Group name GROUP 1
CH set A1, B2 ———
Trip line
1 Off
2 Off
3 Off
q

oFf

Operation complete.
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Setting the Display

Setup Example 4: Setting the Time Scale

Set the time per division of the trend waveform to 2 minutes.

The sampling interval (the time
corresponding to 1 dot) is 4 s when the trend
interval is 2 min.

30 dots x4 s =2 min

Setup Item Description Number in the Figure
Trend interval Set the time per division to 2 minutes. 1

The waveform is updated at every 4 s.

(1) Trend interval
Press MENU (switch to the setting mode) and select Display > Trend/Save interval

' [ =1
o1 154507 a0 T (O 0}

Trend / Save interval

Trend interval [/divl  [EILe——— 1
Save interval 1h

Imin 2min Smin 18min

Operation complete.
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Setting the Data Storage

Setup Example 5: Continuously Record Measured Data and Automatically Save
In this example, we will continuously record and save the measured data of channel 1
and 2.
For the procedure to set the channel, see “Setting the Input Range and Alarm” on page
28. For the procedure to set groups, see “Setting the Display” on page 30.

Automatically save to
the CF card periodically

<>

F1-882
83.9 216.1
Cl m LA

+Channel 1 4 Channel 2
Setup Item Description Number in the Figure
Source channels Channel 1 (TI-001) and channel 2 (FI-002) 1
Data to be recorded  Continuously record the display data from the start of the 2
measurement.
Data storage method  Automatically store every 24 hours. 3
Sampling interval 4 seconds. Set using the trend interval. 4
Sampling interval = (trend interval setting)/30 dots
Data file name Add “sample” to the file name. 5
Example: 000123_sampleYYMMDD_HHMMSS.DAD
1 1
Sequential number Date/Time of the first recorded data
Save Destination DATA-101 6
Directory

(1) Data to be Recorded
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode)

From the basic setting menu, select: A/D, Memory

Basic Setting Mode =

Scan interval

Sean mode | tornal |

Scan interval 2z

A/D intearate Auto

Hemory

Data kind Displave——— 2

Hormal

(2) Method of Storing to the CF Card (Auto Save ON/OFF)
From the basic setting menu, select: Environment > Security, Media save
Basic Setting Hode Cink

Security

-
Communication Ooff

Save

Auto zave n e—+—3
Hedia FIFO Off

Login |Kewlock
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Setting the Data Storage

(3) Save the Settings
1. Press ESC to return to the basic setting menu.
Select End and press DISP/ENTER.
The window appears for you to confirm the saving of the settings.

3. Select Yes and press DISP/ENTER. The DX returns to the operation mode
screen.

(4) Channels to Be Recorded
Press MENU (switch to the setting mode)
From the setting menu, select: Meas Channel > Tag, Memory, Delay
o 12/01 15:03:01 e IEEET(S) 0}
First-CH: B Last-cH: [2
Tag T T 1

Characters [F1-Baz
Hemory sample

On/fOff On
Alarm delay

Time 18 =

(5) Interval for Saving the Data to the CF Card
From the setting menu, select: Display > Trend/Save interval

-
o1 164720 G0 I (O)

Trend / Sawve interwval

Trend interval [/div] [P — 4
Save interval lday &———3

Imin 2min Smin 18min

(6) Data File Name
From the setting menu, select: Data save > File header, File name

File header

Characters

Data file name

Structure Date
Identified strinas Eamp]e e—5

Input

(7) Save Destination Directory (within the CF Card)
From the setting menu, select: Data save > Save directory

§or I (O) )

Save directory

Directory name

Input

Operation complete.
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Setting the Data Storage

Setup Example 6: Saving Measured Data at the Specified Time

Using the settings of Setup Example 5, we will save the measured data once at hour 0

every day.
Everyour 0
T DX T Automatically save
to the CF card

0
All settings other than those listed below are the same as Setup Example 5.

Setup Item Description Number in the Figure

Data storage time Save the data once at hour 0 every day. 7

Data storage method  Automatically save the measured dataat 8
the specified time.

(1) Setting the Time
Press MENU (switch to the setting mode)
From the basic setting menu, select: Timer, Event action > Match time timer

Timer number

Kind Day &—m —— 7
Daw 1 *———
Hour:iHinute BE:08 &
Timer action Repeat &————

(2) Specifying the Data Storage
From the basic settlng menu, select: Timer, Event action > Event action

Logic box number

Event HatchTimeTiner 8
Timer number 1 g
fiction SaveDisplay

Operation complete.
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Customizing the Operation

Setup Example 7: Assigning the Screen Image Data Storage Function to the
USER Key

In this example, we will set the DX so that the displayed screen image data can be saved
to the CF card by pressing the USER key. This function is called snapshot. The extension
of snapshot data files is .png.

YOKOGAWA 4

USER key

Setup Item Description Number in the Figure
Event action Save the screen image data of the DX 1
using the USER key.

(1) Assigning an Action to the USER Key
Press MENU (switch to the setting mode) and select Timer, Event action > Event

action

P =1
151 1650113 e IEE(S) 0}
Logic box number “

Event Uszerkey 1
Action Snapshot j

Operation complete.
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Customizing the Operation

Setup Example 8: Registering Frequently Used Screens to the Favorite Key
Up to eight operation mode screens that are frequently used can be registered to the

Favorite key. This enables you to monitor the operation by using only the Favorite key.
This feature is convenient when comparing data such as historical trends.

‘ ‘ Operation mode screens registered to the Favorite key
(example when three screens are registered)

Favorite key

Favorite key Favorite key

F1-882 L/ H I

204. 4

Favorite key

1. Dlsplay the screen to be registered.

C ' L/H

2. Press FUNC once to display the FUNC key menu.
3. Press the Next soft key to display Favorite regist.

4. Press the Favorite reglst soft key to display the registration list window.

=l

Register the historical trend to the
Favorite key
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Customizing the Operation

5. Press the favorite number (1 to 8) soft key.

6. Press the Regist soft key.

Show the window for entering the
display name

7. Enter the screen name.
Select the digit: Left and right arrow soft keys
Enter characters: ~ Arrow keys and DISP/ENTER
Delete a character: Use the arrow keys to select Del and press DISP/ENTER, or
press the Bs soft key.
Enter the input: Use the arrow keys to select ENT and press DISP/ENTER.
Cancel the setting: Press ESC before pressing DISP/ENTER.
For the input procedure, see “Entering Values and Characters” on page 18.

8. Press DISP/ENTER once.

9. Repeat steps 1 to 8 to register up to eight screens.

Operation complete.
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Operation

Starting the Memory Sample
1. Press START once.
Memory sample starts.

— [t
|]|:||:> . l Memory sample progress
N'ssll DISP: Display data

YOKOGAWA 4 Recording data EVENT: Event data

T1-8A1 F1-A@2

86.6 423
¢l =

.
e

START key

Operation complete.

Stopping the Memory Sample
1. Press STOP once.

2

Display the confirmation window

L HemtHath [ Hemary [ cancel
T
115.8‘ 281.7
clm L/H

2. Select Mem+Math or Memory using the left and right arrow keys.

Memory: Stops memory sample.

Mem+Math: Stops memory sample and computation (option).

On models without the computation function (option), the confirmation message “Do you
want to stop data storage?” appears. Select Yes.

3. Press DISP/ENTER once.

[am=? e
o
Stop memory samping

Operation complete.
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Operation

Switching the Trend Display, Digital Display, and Bar Graph Display
1. Press DISP/ENTER once to show the display selection menu.

Left arrow key

Up arrow key

(S o) Right arrow key

L
mu ;@y@ | DISP/ENTER key

L Down arrow key

Press the down arrow key to select TREND, DIGITAL, or BAR.

3. Press the right arrow key once to display the sub menu. To close the sub menu
that you opened, press the left arrow key.

4. Press the down arrow key to select the group.

Select DIGITAL > GROUP 1

= FI-682
- 91.2 232.4
Clm L/

5. Press DISP/ENTER once to show the operation display of the selected group. To
close the menu without switching the display, press ESC.
Group number

a1 11:31:16 -“” —m@

102 1 o denty
254 4

Operation complete.

T1-801

F1-0802

Press the down arrow key when the trend, digital, or bar graph is displayed to switch the
display in the order trend, digital, bar graph, trend, and so on. Press the up arrow key
to switch the display in reverse order. Press the right arrow key or the left arrow key to

switch the group.
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Operation

Writing the Message “START”
Registering the Word “START” in Message Number 1

1. Press MENU (switch to the setting mode) and select Message.
2. Press the 1-10 soft key.
3. Press the Input soft key.

2 2/81

Hess ETarTll
4 +]

1
2
2
4 Show the message registration window
5
E
7
g
g
1
4
Select the digit: Left and right arrow soft keys
Enter characters: Arrow keys and DISP/ENTER

Delete a character: Use the arrow keys to select Del and press DISP/ENTER, or
press the Bs soft key.

Enter the input: Use the arrow keys to select ENT and press DISP/ENTER.

Cancel the setting: Press ESC before pressing DISP/ENTER.

For the input procedure, see “Entering Values and Characters” on page 18.

4. Press DISP/IENTER.

o1 20:a1:00 e HEEENN(O) 69
Hezsage Mo,

Characters
ETART

1a

5. Press ESC or MENU to return to the operation mode screen.

Operation complete.
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Operation

Writing Message Number 1 “START”
This operation can be carried out while memory sample is in progress. The message is

displayed on the trend display. Show the trend display first.

1. Press FUNC (display the FUNC key menu), press the Message soft key, and

press the 1-10 soft key.
GROUF 1

Show the message registration window

1 soft key

11’<\ldiu

v 11:13 STHRT @ Shows the message
(time, message, and message mark)
Also recorded to the internal memory

T1-8A1 F1-A@2

9.7 169.6
(| /H

Operation complete.
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Connecting to an Ethernet Network

Setup Example 9: Monitoring the DX on a PC Browser

In this example, we will connect the PC and the DX via hub in a one-to-one relationship
and display and monitor the DX screen on a browser on the PC.

Ethernet

[ ] DX
3 ]
:g : i
w

DX
Setup Item Description Number in the Figure
IP address 192.168.1.101 1
Subnet mask 255.255.255.0

Web server function

Monitor from a Web browser on the PC
using operator page.

Access to the DX

Display the Web page and do not set
access privileges.

PC
Setup Item Description Number in the Figure
IP address 192.168.1.100 4

Subnet mask

255.255.255.0

(1) IP Address of the DX
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode)

From the basic setting menu, select: Communication (Ethernet) > IP-address

Basic Setting Hode

IP-address
DHGP

Fixed IP-address
IP-address
Subnet mask
Default gatewaw

192.168. 1.181 :71
255,266,255, @

@, @, 8. @
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Connecting to an Ethernet Network

(2) Enabling the Web Server Function on the DX
From the basic setting menu, select: Communication (Ethernet) > Server
Basic Setting Mode ik

Server

FTP

Web Usze —— 2
SHTP Mot

Hodbus Mot

On/fOff (n
Access control 0ff
Command Mot

Operator|Honitor

(4) Save the Settings
1. Press ESC to return to the basic setting menu.

2. Select End and press DISP/ENTER.
The window appears for you to confirm the saving of the settings.

3. Select Yes and press DISP/ENTER.
The DX returns to the operation mode screen.

(5) Setting the PC
Set the IP address and subnet mask on the PC.

Intemet Protocal (TCP/IP) Fioperties ) 2]

General |

‘You can get IP settings assigned automatically if your network, supports
this capability. Othemwise, you need to ask pour netwaork administrator for
the appropriate IP settings.

" Dbtain an IP addiess automatically
—f% Use the following IP address:

IP address: 192 168 . 1 100 @ 4
Subret mask: 265.255.250. 0 @ l
Default gateway: i F E

 [htain DNG server address automatically

—f% Use the following DNS server addresses

Prefered DMS server:
Altemate DNS server, ’ 5 F
Advanced.
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Connecting to an Ethernet Network

(6) Checking the Connection

Send the command below from the PC and check that a correct response is returned.

Send
>ping 192.168.1.101

Response example
>Reply from 192.168.1.101: bytes=32 time<10ms TTL=255

(7) Displaying the DX Screen on the Browser
1. Start the browser on the PC.
2. Enter the following URL.
http://192.168.1.101/operator.htm

3. Check that the DX screen appears.

2Y OPERATOR MODE[MAINE192.168.1.101 - Microsaft Intemet Explores

JFlIe Edit View Favorites Tools Help

=10l x|

| 4

J Q- - ¥ & | ) searth ¢ Favories P veds el‘ =

| Address [{E] hrep:f192.188.1. 101 foperator. htm

Tl B || ks

Auto Refresh m Z
Al Channels Log.

B-EmlE

5] =] T 123 1@ ps o]
vl R L e e b b bana b e

2minsdil

P 1
2481 @3:11:17

|&] Done

oo

TREND |
Select Group =» ¥

Select Group => =
(e} %
Select Screen=> *

[ [ reemet =

Operation complete.
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Connecting to an Ethernet Network

Setup Example 10: Automatically Transferring the Measured Data File to an FTP

Server
In this example, we will configure the DX so that the measured data is automatically

transferred to an FTP server on the network when the measured data is automatically
saved to the CF card. To automatically transfer the measured data files and report files,
the auto saving of the measured data must be configured in advance (“Data storage
method” of Example 5).

This example assumes that the following network environment is used: DHCP enabled,
automatically obtain the DNS server information, and automatically register the DX host
name to the DNS server. Set the parameters according to your network environment.

Automatic data transfer to an FTP server

DX | ]|FTP server
| |
/\/ » <> @CF card
Measurement input

Ethernet

/\Internal

Setup Item Description Number in the Figure
Host name DAQSTATION1 1
Obtain the IP address Obtain automatically (DHCP) 2
Type of data to be transferred  Acquired measured data 3
FTP server Server name  abcdefg.co.jp 4

Port number 21
Login name ftpuser1
Password al1234

(1) IP Address of the DX
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode)
From the basic setting menu, select: Communication (Ethernet) > IP-address

Basic Setting Hode

IP-address
DHeP .2
DNS accession Use _e———— Automatically obtain the DNS server information.
Host-name register Use  &——— Automatically register the DX host name to the

DNS server.

(2) Host Settings Address of the DX
From the basic setting menu, select: Communication (Ethernet) > Host settings

Basic Setting Hode
Host zettings

Host name

Input
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Connecting to an Ethernet Network

(3) Data to Be Transferred to the FTP Server

From the basic setting menu, select: Communication (Ethernet) > FTP client > FTP
transfer file

FTP transfer file

DispkEvent data e 3
Report 0ff
Snapshot Ooff

(4) Connected setting FTP Server

From the basic setting menu, select: Communication (Ethernet) > FTP client > FTP
connection

Basic Setting Hode
FTP connection

Server name pbcdefs o—— 4
Port number 2 &
Login name If tpuserl *—
Password p1234 *—
Account

PASY mode Off

Initial path

Primary | Second
(5) Save the Settings
Press ESC to return to the basic setting menu.

2. Select End and press DISP/ENTER.
The window appears for you to confirm the saving of the settings.

3. Select Yes and press DISP/ENTER.
The DX returns to the operation mode screen.
Operation complete.

Executing a File Transfer Test
1. Press FUNC once to display the FUNC key menu.

3. Press the Primary soft key once. The messages “FTP test is being executed” and
“Execution is complete” are displayed. The test file (FTP_TEST.TXT) is sent to the
FTP server.

Operation complete.

Transferring the Data Files
When you start memory sample, the measured data file is transferred to the FTP server
when the data is saved to the CF card.
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Using DAQSTANDARD

Displaying the Measured Data on DAQSTANDARD

In this example, we will display the measured data using the accompanying software

program, DAQSTANDARD.

1.

Insert the CF card containing the measured data file (.DAD or .DAE extension)

into the PC that has DAQSTANDARD installed.
Start DAQSTANDARD. The launcher is displayed.

CONFIS

L Data viewer icon

Click the data viewer icon to start the data viewer.

wer

=10l x|

File ¥iew Help

|SH|Eme@aauumnty &[Sz EE0ED i e 3R

[14n Ap{ 4B Bb! IR ANT 4B BT

Ready o«

From the File menu, choose Open.

In the Open dialog box, select the desired file, and click Open.
The data is displayed.

BR=I1
== x|

Time:

ert  Information Help

@Rk eaauumnye|EEl T EE0ES D R ST

| 140 b 142 B4 | Fin AT e BiY

I\ /
\/ \J
T =

16:56.00 17:.00.00 17:.04.00

16:52.00

'TITILEE Absolute Time [fum:s]
<L W) b
ot i

Operation complete.
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Installation and Wiring

Installation Location
Install the DX indoors in a location that meets the following conditions.

Instrumentation Panel

The DX is designed to be installed in an instrumentation panel except for the desktop
type.

Well-Ventilated Location

To prevent overheating, install the DX in a well-ventilated location. For the panel cut
dimensions when arranging multiple DXs, see the page 50. Follow the panel cut
dimensions providing adequate space between instruments when other instruments
are arranged on the panel. For the desktop type, we recommend that a space of at
least 50 mm be provided around the left, right, top, and rear panels of the DX.
Minimum Mechanical Vibrations

Choose an installation location with the minimum mechanical vibration. Installing the
DX in a location with large mechanical vibration not only causes adverse effects on
the mechanism but also may hinder normal recording.

Horizontal

Install the DX horizontally (However, the DX can be inclined up to 30 degrees
backwards for panel mounting).

Note

Condensation may occur if the DX is moved to another place where the ambient

temperature is higher, or if the temperature changes rapidly. In addition, measurement
errors will result when using thermocouples. If this happens, let the DX adjust to the new
environment for at least one hour before using it.

Do not install the DX in the following places.

Outdoors

In Direct Sunlight or Near Heat Sources

Install the DX in a place with small temperature fluctuations near room temperature
(23°C). Placing the DX in direct sunlight or near heat appliances can cause adverse
effects on the internal circuitry.

Where an Excessive Amount of Soot, Steam, Moisture, Dust, or
Corrosive Gases Are Present

Soot, steam, moisture, dust, and corrosive gases will adversely affect the DX. Avoid
such locations.

Near Strong Magnetic Field Sources

Do not bring magnets or instruments that produce electromagnetic fields close to the
DX. Operating the DX in strong magnetic fields can cause errors in the measurements.
Where the Viewing of the Display Is Poor

The DX uses a TFT color LCD for the display. Therefore, viewing of the display from
an extreme angle is difficult. Install the DX so that the user can view the display from
the front.

48
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Installation and Wiring

Installation Procedure
Installation Procedure (Panel Mount Type)
Use a steel panel of thickness 2 mm to 26 mm.
1. Insert DX from the front of the panel.

2. Mount the DX to the panel using the mounting brackets that come with the
package as shown in the figure below.

» Use two brackets to support the top and bottom or the left and right sides of
the case (remove the seal that is covering the holes for the mounting brackets
beforehand).

» The proper torque for tightening the mounting screws is 0.7 to 0.9 N-m.

* Mount the DX to the rack according to the procedure below.

« First, attach the two mounting brackets and temporarily fasten the
attachment screws.

* Next, fix the DX in place by tightening the attachment screws with the
appropriate torque. When the DX is approximately perpendicular to the
panel as you fasten the screws, press the mounting bracket against the
case so that they are in contact with each other.

A CAUTION

» Tightening the screws too much can deform the case or damage the bracket.
» Be careful not to insert foreign objects or tools through the holes for the
mounting brackets in the case.

Panel Mounting Diagram

|Screw temporarily|

DX case

Mounting

Mounting Panel | brackets
brackets

Attachment screw
I—Torque driver
o s } (ﬂat blade)

Attachment
screw

Front In contact with

each other

(The figure shows the case when the mounting brackets
are used on the top and bottom of the case.)

Note

To achieve sufficient dust and water proof performance, mount the DX in the middle of the
panel cut out.

Installation (Desktop Type (/H5[ ] Option)
The front (leg) stand can be pulled out.

CAUTION

On the desktop type, do not apply force to the DX when the front leg (stand) is
out. This can break the front leg.
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Installation and Wiring

External Dimensions and Panel Cut Dimensions
Unit: mm (approx. inch)
Unless otherwise specified, tolerance is *3%
(however, tolerance is £0.3 mm when below 10 mm).

Panel mount type = i DX1000 | DX1000N
3o *1 | 228.5(9.0) |258.5 (10.18)
=) U 0| [%2]224.1(8.82) [254.1 (10.0)
®|6 [*3[170.5 (6.71) | 200.5 (7.89)
*4 140.9 (1.61) [30.9 (1.22)
*5141.4 (1.63) | 34.9 (1.37)
*6 | 103.4 (4.07) [ 103.4 (4.07)
MAX *1 (/H2 or /PM1) *7 199.9 (3.93) |106.3 (4.19)
24.0 *2 o _
151.5 (5.96) (094] 3 et s "
. 144 (5.67) 21026 <[5
_f.| |(AIIowabIepanelthickness) o =3
\ ]
8 ) D .
&l g o 0 D ol
0| 1™
~ < 2 L kS
* 3 E -~
;"]:D g = . . 0
6 MAX 28.0 (1.10) RE
(/KB1 or IKB2) NS
' (Dimensions after attaching
the mounting bracket)
Panel cut dimensions
Single-Unit Side-by-Side Mounting Side-by-Side Mounting
Mounting (horizontally) (vertically, max. 3 units)
1372 : w2
137°% Units L%
(5.39) - T (539) | 2 |282 (11.10)
i — 175 MIN 3 426 (16.77)
137°% (6.89) 4 |570 (22.44)
(5.39) 13772 N 5 [714(28.11)
—L (539 - L+ |6 [858(33.78)
- ' ' 0 7 1002 (39.45)
| L2 | 8  [1146 (45.12)
. 0 | 9 [1290 (50.79)
10  [1434 (56.46)
1 n_ |(144xn)-6
175 MIN
(6.89)
Desktop type (/H5[ ] Option)
¢
q
)
[N
1)
144.3 MAX 252.5 (99.4) (/H2 or /PM1)
(5.68) _ =
“f )
a< | ( \ =
‘ |
o3 JAEE:
J|w = e
u
0 m =
R Eleﬂ_q_. = 1
— of~
< B -8
e =)
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Installation and Wiring

Input Signal Wiring

A

» To prevent electric shock while wiring, ensure that the power supply source is
turned OFF.

CAUTION

« If a strong tension is applied to the cable wired to the DX, the terminals of the DX
and/or the cable can be damaged. In order to prevent tension from being applied
directly on the terminals, fasten all wiring cables to the rear of the mounting
panel.

» To prevent fire, use signal wires having a temperature rating of 70°C or more.

» Do not apply a voltage exceeding the following value to the input terminals.
Otherwise, damage to the DX may result.

* Maximum input voltage: +60 VDC
* Maximum common mode voltage: 60 VDC (under measurement category Il
conditions)

» The DX is a product of installation category Il.

Precautions to Be Taken While Wiring

Take the following precautions when wring the input signal cables.
It is recommended that crimp-on lug with insulation sleeves (designed for

4-mm screws) be used when connecting the input/output signal wires to
the terminals. However, this does not apply clamped terminals (/H2).

@@—Crimp-on lug with insulation sleeves (for 4 mm screws)

For clamped terminals (/H2), the following wire is recommended.

» Conductive cross-sectional area: 0.08 mm2 to 1.5 mm2 (AWG 28 to 16)

» Length of the stripped section of the wire: Approx. 7 mm

Take measures to prevent noise from entering the measurement circuit.

* Move the measurement circuit away from the power cable (power circuit) and ground
circuit.

+ Itis desirable that the object being measured does not generate noise. However, if
this is unavoidable, isolate the measurement circuit from the object. Also, ground the
object being measured.

» Shielded wires should be used to minimize noise caused by electrostatic induction.
Connect the shield to the ground terminal of the DX as necessary (make sure you are
not grounding at two points).

* To minimize noise caused by electromagnetic induction, twist the measurement circuit
wires at short, equal intervals.

* Make sure to earth ground the protective ground terminal through minimum resistance
(less than 100 Q).

When using internal reference junction compensation on the thermocouple

input, take measures to stabilize the temperature at the input terminal.

* Always use the terminal cover.

» Do not use thick wires which may cause large heat dissipation (cross sectional area of
0.5 mm? or less recommended).

* Make sure that the ambient temperature remains reasonably stable. Large
temperature fluctuations can occur if a nearby fan turns ON or OFF.

Connecting the input wires in parallel with other devices can cause signal

degradation, affecting all connected devices. If you need to make a parallel

connection, then

» Turn the burnout detection function OFF.

» Ground the instruments to the same point.

» Do not turn ON or OFF another instrument during operation. This can have adverse
effects on the other instruments.

» RTDs cannot be wired in parallel.

IM 04L41B01-02E
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Installation and Wiring

Wiring Procedure

A terminal cover is screwed in place on the measuring input terminal block on the rear
panel. A label indicating the terminal arrangement is affixed to the cover.

1. Turn OFF the DX and remove the terminal cover.

2. Connect the signal wires to the terminals.

3. Replace the terminal cover and fasten it with screws. The proper torque for
tightening the screws is 0.6 N-m.

Nofte

Input signal wires of diameter less than or equal to 0.3 mm may not be secured firmly for
clamped terminals (/H2). Fold over the conducting section of the wire, for example, to make
sure that the wire is securely connected to the clamped terminal.

Arrangement of the Input Terminals

Input terminal block of
the DX1002 and DX1002N

Input terminal block of
the DX1004 and DX1004N

Input terminal block of
the DX1006 and DX1006N

Input terminal block of
the DX1012 and DX1012N

Screw terminal

CH2

ﬁ-— Input terminal block

CH1
|| &%) I
|| 99 +A
%) -IB
CH4 CH2
CH3 CH1
|| PRPD Ib
|| DRDD [ |wa
RRRR]_[ .
CH6 CH4 CH2
CH5 CH3 CH1
. RS Ib
|| 59)69/69) %) 6969 " |+a
PR@R@@ | |
CH12 CH10 CH8 CH6 CH4 CH2
H11 CH9 CH7 CH5 CH3 CH1
BERRRRRREEER| b
BB @@@RRRRR® )+
PEERRRRRRRDD |-

Clamp terminal

CH1
o L /b
i +A
-IB
CH2
CH3 CH1
= ™ L /b
H+A
W Wm
CH4 CH2

L /b
[ -/B

+A
-IB

CH12 CH10 CH8 CH6 CH4 CH2
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Installation and Wiring

Wiring Screw Terminals
DC voltage input/DI (ON/OFF) input TC input

Compensating leadwire

+ +

+
DC voltage input _+

\)
RTD input DC current input
b
A \ + +
[ .

B A DC current input

B — -

b

Shunt resistor

K Example: For 4 to 2? mA input, use a
shunt resistor of 250 Q+0.1%.

Lead wire resistance per wire of
10 Q or less. Make the resistance
of the three wires equal.

Wiring Clamped Terminals

Remove the terminal block Connect the wires Connect the terminal block

Hold both ends of the terminal Hold both ends of the terminal block,
block and pull straight. align with the connector on the DX
side, and push the terminal block into
the connector.

Recommended
length of stripped
wire: 7. mm

Clelelelele,

Recommended wire size
0.08 to 1.5 mm? (AWG 28 to 16)

Input signal wire

First, loosen the screw at the front using a
flat-blade screwdriver. Insert the input signal
wire into the slit on the right side of the

terminal block, and fasten the screw at the front.

Note

RTD input terminals A and B are isolated on each channel. Terminal b is shorted internally
across all channels. However, terminal b is also isolated on each channel on models with the
/N1 option (Cu10, Cu25 RTD input/3 leg isolated RTD) and /N2 option (3 leg isolated RTD).
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Installation and Wiring

Optional Terminal Wiring

A

To prevent electric shock while wiring, ensure that the power supply source is
turned OFF.

If a voltage of more than 30 VAC or 60 VDC is to be applied to the output
terminals, use ring-tongue crimp-on lugs with insulation sleeves on all terminals
to prevent the wires from slipping out when the screws become loose.
Furthermore, use double-insulated wires (dielectric strength of 2300 VAC or
more) for the signal wires on which a voltage of more than 30 VAC or 60 VDC is
to be applied. For all other wires, use basic insulated wires (dielectric strength of
1390 VAC). To prevent electric shock, attach the terminal cover after wiring and
make sure not to touch the terminals.

CAUTION

Use the following circuit voltage for the connection to the alarm/FAlL/status
output terminal.
*  When the connection is to Mains Circuits (primary AC power source circuits):
150 V or less
*  When the connection is to circuits derived from Mains Circuits (secondary
circuits): 250 V or less
(Mains Circuits voltage is less than 300 V, and connection must be used by
isolation transformer.)
To prevent fire, use signal wires having a temperature rating of 70°C or more.
If a strong tension is applied to the cable wired to the DX, the terminals of the DX
and/or the cable can be damaged. In order to prevent tension from being applied
directly on the terminals, fasten all wiring cables to the rear of the mounting
panel.
Do not short the transmitter power supply output terminal or apply external
voltage to it. If you do, the DX may malfunction.
When using the transmitter power supply output terminal, do not use current
that exceeds the maximum output current (25 mADC). If you do, the DX may
malfunction.

Nofte

For remote control wiring, use shielded wires to reduce noise. Connect the shield to the
functional ground terminal or the ground terminal of the DX.

Precautions to Be Taken While Wiring
It is recommended that crimp-on lug with insulation sleeves (designed
for 4-mm screws) be used when connecting wires to the optional input
terminals.

@@—Crimp-on lug with insulation sleeves (for 4 mm screws)

Wiring Procedure
As shown in the figure on next page, the optional terminal block is located on the rear
panel. The optional terminal block is provided on the DX when an option that requires
input/output is installed such as the alarm output relay (/A[ ] option), FAIL/status output
relay (/F1 option), and remote control function (/R1 option), etc. A terminal cover is
screwed in place on the measuring input terminal block. A label indicating the terminal
arrangement is affixed to the cover.

1.
2,
3.

Turn OFF the DX and remove the terminal cover.
Connect the signal wires to the terminals.

Replace the terminal cover and fasten it with screws. The proper torque for
tightening the screws is 0.6 N-m.
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Installation and Wiring

Arrangement of the Optional Terminals

e-H— Optional terminal block

e
Symbols such as "NC": Terminal functions
Alarm output, FAIL/status output| Remote control input Pulse input Transmitter power supply
NC: Normally close 1 to 8: Terminal number Hand L: See page 57. +and-: See page 57.
C: Common C: Common

NO: Normally open
@ A terminal that is not used. (With a screw)
|:|Aterminal that is not used. (Without screw)

IA1 IA2 IA3
Alarm Alarm Alarm
output output ou}t\put
f—/% r N
02 01 04 0302 01 06 0504 0302 01
@ [R@ [@Inc] |ne & [RIne| Inc|ne] [ne NC| Inc|nc| |Nc|nc| [Nc
@ @@ @c| |c @ @c| [cle| |c Cl lc|c| |c|c| |c
@ @@ [@no| |no @) |@Ino|  [Nojno| [no NO| Ino[No| |No[NO| [NO
5
o
y
IA1/R1 IA2/R1 IA3/R1 )
Alarm Remote Alarm Remote Alarm Remote o
output control output control output control =]
input —_—— input P A N input ]
02 01— 04 0302 01— 06 0504 0302 01— 2
s
@ @@ [@Ine] nc[e[s]c] (€] [@Ine] Incne] [nefe[3c] Nl IncInc| Incnc] [ncls s c 5.
=]
@ @R @ c cl7la7] @ ®@c| |clc| |c|7]afa] L] [cle| [cle cl7]4]4 2
@ RR) |@vo| nols [5[5] (@ (@9INo|  |Nojno| [No[8 |5 [, | INO| |nojno| [Nojno| [Nojs |5 |,
IR1 IA1 IF1 IA2 IF1
Remote Alarm Alarm
control %tl?tgjust output %tuatt;ust output
input FAIL — FAIL
v 02 01 l 04 0302 01
3(c] NS [Nc[@) [@[Ne| Inc NC| Inc|Nc| |Nc|Nc| [Nc
al7] L& [c[® @ c| |c Cl |clc| |clc| |c
8(5[,| N9 [No[@) (@[Nno| [No NO|  Ino[No| |no[NO| [NO
IF1 IA1/F1 /R1 IA2 [F1 IR1
Status Status Alarm Remote Status Alarm Remote
output output output control output output control
FAIL FAIL —"—— input AL ———"———  input
l l 022 01— l 04 0302 01—

NCl Inc(@
N Inol@)

NCl  INc(@®| |@Inc| |Nc|e|3[c] INC| |Nc|Nc| [Nc|Ne| [Ncle |3 [
Cl |c|@ @ c| |c|7|al4] [C] |c|c| [clc| |c|7|a[qy
NO| INo|¢? |@)INo| |Nojs |5 [, | [NO |NojNo| |no|no| [No|8 |5 [,

QO®
VO®
VO®

(To next page)
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Installation and Wiring

IF1 /R1
Status Remote
output control
FAIL l input
NC
N (D) [@D)e (3¢
C
c @ @S| @744
NO
N (BP) [@) s s
/A1 [F1 /PM1
Status
output Alarm Pulse Remote
output input  control
FAIL —_— —A— input
02 01 8 7 6
NC| INcNc| |nc| |H[H|H|3[¢
Cl fclc| [c| |L|L|L|a[y
NO|  INojno| [NO 5[5
/A1 /TPS2
Transmitter Alarm
power output
supply
~ 02 01
t+ NC| |NC
|- c c
NO NO
ITPS2
Transmitter
power
supply
K—M
i+

R
IR

(From previous page)

/A1 /PM1
Alarm Remote
output lT#[I)Suet c_ontr?l
inpu
02 01 8 7 66—
& @Ine|] [ne[ [n[u[u[s|g
& @c| [c| |L|L|L|afy
& @9No|  |No 2
/PM1
Pulse Remote
input Cﬁ%ﬂ?'
8 7 6 ¢ '
H[H|H|3[¢
LIL|L|4 |4
2
/A1 IR1 ITPS2
Transmitter Alarm Remote
power output control
supply input
L 02 o —
t+ Nc| |Nc|6 |3 [¢
- Cc C 4 1
No| [No|8 |5 [,
IR1 ITPS2
Transmitter Remote
power c_ontrol
Supp|y input
~—
T+ & (@3¢
-l - & (@744
@) (@ 8]5]2

/A2 |IPM1
Alarm Remote
output 'T#FI)SU? c_ontr?l
Inpu
04 03 02 01 8 7 6 R
NC| INc|nc| [nNc| [H|H|H|3[¢
€l lcle| |c| |L|L|L|aly
NO|  InojNo| [NO 5[5
[F1 /PM1
Stattust Pulse Remtottle
outpu i contro
FalL 4P iUt Gaput
l 8 7 6 ¢ N
N Te[@] (@] [w][H]n]s]c
Cl[c@ (@ |ui|Laly
Ol no&D (@ 52
ITPS4
Transmitter
power
supply
[+ +
IR1 [TPS4
Transmitter Remote
power control
Supp|y input
+
+ |+ |+ 63 ¢
=== 7044
8 (5|2
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Installation and Wiring

Alarm Output Terminal, FAIL Output Terminal, and Status Output Terminal

(/A1, IA2, IA3, and /F1)
NC Output format: Relay contact
c Contact rating: 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistor load)

NO Withstand voltage: 1600 VAC at 50/60 Hz for one minute
(between output terminals and the ground terminal)

Remote Control Input Terminal (/R1)

* Relay contact input
(voltage-free contact)
Contact closed at 200 Q
Contact open at 100 kQ or greater

* Transistor input (open collector)

ON voltage: 0.5V or less (30 mADC)
Leakage current when turned OFF:

Internal circuit

Vv
Input format:
Photocoupler isolation

0.25 mA or less Shared common (C)

: 5
[ @_% Allowable input voltage:
7 4 1 ' 37
8 5 2

Withstand voltage: 1000 VDC for one minute between
input terminals and the ground terminal

Pulse Input Terminal (/PM1)

* Relay contact input
(voltage-free contact)
Contact closed at 200 Q or less ON voltage: 0.5V or less (30 mADC)
Contact open at 100 kQ or greater ~ Leakage current when turned OFF:

Allowable input voltage:

0.25 mAor less
8 7 8 7 6 H
T/ HT/ Ho o—&H H H H ’ 30 VDC
L L : L L L ' 37

Withstand voltage: 1000 VDC for one minute between
input terminals and the ground terminal

24 VDC Transmitter Power Supply Output Terminal (/TPS2 and /TPS4)

Connect the DX to the transmitter as shown below.

-
t
(<]

*Transistor input (open collector) Internal circuit

| S5V Input format:
E Photocoupler isolation
! Shared common (L)

DX

Current

Transmitter power
supply output

terminal Transmitter

U

Input terminal

Shunt resistor: 250 Q

Note

To reduce noise, use a shielded cable for wiring. Connect the shield to the functional ground
terminal or the ground terminal of the DX.

Serial Interface
Connecting to the RS-232 Connector (/C2)

12345 2 RD (Received Data): Received data from the PC. Input signal to the DX.
\ | | | 3 SD (Send Data): Transmitted data to the PC. Output signal from the DX.
D S 5 SG (Signal Ground): Signal ground.
@ 500 @ 7 RS (Request to Send): Handshaking signal when receiving data from the PC. Output signal
from the DX.
é ’7 18 \9 8 CS (Clear to Send): Handshaking signal when transmitting data to the PC. Input signal to
the DX.

*Pins 1, 4, 6, and 9 are not used.
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Installation and Wiring

Connecting to the RS-422A/485 (/C3)

Four-wire system Two-wire system

oloflo|lo|o]|o DDE.--EI--i
@@@@@@ @@@@

4 | FG (Frame Ground) Frame ground of the DX.
@)|@)| SG (signal Ground) Signal ground.
SDB (Send Data B) Send data B (+).
E @ SDA (Send Data A) Send data A (-).

I | I | [ — RDB (Received Data B) Receive data B (+).
SG SDB SDA RDB RDA FG SG SDB SDA RDB RDA

RDA (Received Data A) Receive data A (-).
< Shield

Electric potential of the shield

Recommended length of stripped wire: 9 mm. Recommended tightening torque: 0.4-0.5 Nem

Cable
There are two types of cables available, the four-wire cable and the two-wire cable (used only for the
Modbus protocol). The cable should meet the following specifications.
* Type: Shielded twisted pair cable: 3 pairs 24 AWG or more (four-wire),
2 pair 24 AWG or more (two-wire)
* Characteristic impedance: 100 Q
+ Capacitance: 50 pF/m
+Total cable length: Upto 1.2 km

Connecting to the USB Port (/USB1)
The USB port complies with Rev. 1.1.

Front Rear
]

@[]~ USB port

CF_CARD

Connecting to the Ethernet Port
Ethernet port

[ Indicator

Checking the Connection/Communication Status
The connection status of the Ethernet interface can be confirmed with the indicator that is
located above the Ethernet connector of the DX.

Indicator Connection Status of the Ethernet Interface
llluminated (green) The Ethernet interface is electrically connected.
Blinking (red) Transmitting data.

Off The Ethernet interface is not electrically connected.

Checking the Connection on the DX Display
¢ Checking the Connection at the status indication section of the DX
display.
You can check the connection status of the Ethernet interface on the Ethernet Link
indicator located on the right side of the status indication section of the basic setting
mode display. The basic setting menu appears by pressing MENU to display the
setting menu followed by FUNC for approximately 3 s.

* Checking the Connection Status in the Display Section in the Upper
Right Corner of the COMMUNICATION LOG Display of the DX
You can check the connection status of the Ethernet interface on the Link indicator on

the display section in the upper right corner of the COMMUNICATION LOG display.

Indicator Connection Status of the Ethernet Interface
llluminated (green) The Ethernet interface is electrically connected.
Off The Ethernet interface is not electrically connected.
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Installation and Wiring

Power Supply Wiring
Panel Mount Type, or Desktop Type with /P1 (Models with /H5 and /P1 Options)
Precautions to Be Taken While Wiring the Power Supply
Make sure to follow the warnings below when wiring the power supply. To prevent electric
shock and damage to the DX, observe the following warnings.

A WARNING

« To prevent electric shock when wiring, ensure the main power supply is turned
OFF.

» To prevent the possibility of fire, use 600 V PVC insulated wire (AWG20-16) or
an equivalent wire for power wiring.

* Make sure to earth ground the protective earth terminal through a grounding
resistance less than 100 Q before turning ON the power.

+ Use crimp-on lug with insulation sleeves (for 4-mm screws) for power supply
wires and protective grounding wires.

» To prevent electric shock, make sure to close the transparent cover for the
power supply wires.

» Make sure to provide a power switch (double-pole type) on the power supply line in
order to separate the DX from the main power supply. Put an indication on this switch
as the breaker on the power supply line for the DX and indications of ON and OFF.
Switch specifications

Steady-state current rating: 1 A or more (other than /P1), 3 A or more (/P1).
Inrush current rating: 60 A or more (other than /P1), 70 A or more (/P1).
Use a switch complies with IEC60947-1, 3.

* Connect a fuse (between 2 A and 15 A) to the power line. Use a fuse approved 5
by CSA (for the use in North America) or VDE (for the use in Europe). E’;
» Do not add a switch or fuse to the ground line. g’-
g
Use a power supply that meets the following conditions: o
Item Other than /P1 IP1 EE‘
Rated supply voltage 100 to 240 VAC 24 VDC/AC (g
Allowable power supply voltage range 90 to 132/180 to 264 VAC 21.6V to 26.4 VDC/AC
Rated power supply frequency 50/60 Hz 50/60 Hz (for AC)
Allowable power supply frequency range  50/60 Hz + 2% 50/60 Hz+2% (for AC)
Maximum power consumption 45 VA (100 V)/60 VA (240 V) 28 VA (for DC), 45 VA (for AC)
Note

Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on
the measurement accuracy.

Wiring Procedure
1. Turn OFF the power to the DX and open the transparent power terminal cover.

2. Wire the power cord and the protective ground cord to the power supply terminals.
Use ring-tongue crimp-on lugs (designed for 4 mm screws). The proper torque for

tightening the screw is 1.4 to 1.5 Nem (12.4 to 13.2 inchelbs).

> Other than /P1 /P1
(24 VDC/AC power supply)

100-240V  AC~ 24VDC &= 28\AMAX

50/60Hz 60VA MAX 24V C ~50/60Hz 45\ MAX

] [ [l O]
Note
Do not wire the protective grounding
cord to the functional ground terminal.

Power cord

3. Replace the power terminal cover, and fasten it with screws.
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Installation and Wiring

Desktop Type (/H5[ ] Option)
Precautions to Be Taken While Connecting the Power Supply
Make sure to follow the warnings below when connecting the power supply. To prevent

electric shock and damage to the DX, observe the following warnings.

A

Before connecting the power cord, ensure that the source voltage matches the
rated supply voltage of the DX and that it is within the maximum rated voltage
range of the provided power cord.

Connect the power cord after checking that the power switch of the DX is turned
OFF.

To prevent electric shock or fire, be sure to use the power cord supplied by
YOKOGAWA.

Make sure to perform protective earth grounding to prevent electric shock.
Connect the power cord of the desktop type to a three-prong power outlet with a
protective earth terminal.

Do not use an extension cord without protective earth ground. Otherwise, the
protection function will be compromised.

Use a power supply that meets the following conditions:
Item Condition
Rated supply voltage 100 to 240 VAC
Allowable power supply voltage range 90 to 132, 180 to 264 VAC
Rated power supply frequency 50/60 Hz
Allowable power supply frequency range 50/60 Hz + 2%

Maximum power consumption

45 VA (100V) and 60 VA (240 V)

Note

Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on
the measurement accuracy.

Connection Procedure

1.

Check that the power switch is OFF.

2. Connect the power cord plug to the power connector on the rear panel. (Use the

power cord that comes with the package.)

3. Check that the power outlet meets the conditions given in the table above and

that the supply voltage is within the maximum rated voltage range of the power
cord that comes with the package. Then, connect the other end of the power cord
to the power outlet. The AC outlet must be of a three-prong type with a protective
earth ground.
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Recommended Replacement Periods for Worn Parts

To preserve the reliability of the DX and to use the DX in a good condition for an
extended time, it is recommended that periodic replacements be made on parts. The
following table shows the recommended replacement period for expendable parts.

The replacement period shown here applies when the recorder is used under standard
operating conditions. For the actual replacement period, consider the actual conditions
of use. Replacement of parts will be carried out by a YOKOGAWA engineer or an
engineer certified by YOKOGAWA. Contact your nearest YOKOGAWA dealer when such
replacement is necessary.

Item Reglacement Name Part No. Quantity Notes

period Used

LCD 5 years Back Light Unit B8703KB 1

Battery 10 years Battery Assembly B9900BR 1

Dust and water 5 years Packing B8705FY 1

proof strip 5 years Key Case Assembly B8705BM 1 Without /KB1 or /KB2
5 years Key Case Assembly B8705BY 1 With /KB1 or /KB2

Aluminum 5 years* Power Supply Assembly |- 1

electrolytic capacitor |5 years* AD Assembly Depends on the model

* Replacement period at the upper limit of the normal operating temperature (50°C)
The replacement period varies depending on the operating temperature and the specifications of the DX.
The lower the operating temperature, the longer is the replacement period. For example, if the operating
temperature is 30°C, it may be possible to use the parts for more than 10 years.

Nofte

» The LCD replacement period indicates the half life of the brightness when the brightness
is set to the factory default setting. The half life is shortened as the brightness is set
higher. The deterioration of brightness varies depending on the condition of use, and its
determination is subjective. Consider these facts for determining the actual replacement

period.
» The color of the LCD may become yellowish as time elapses. The discoloration tends to
progress faster as the brightness is set higher.
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Setup Items and Default Values

The setup items and the default values in the setting mode are listed below. Enter the
settings that you are using in the Setting column for your convenience.

Setting mode menu

[ = -
/Al 17:56:41 ‘Red LI (O]

Setting menu
Page 63
Heas channz] b Page 63 to 65
Hath channel b Page 66 and 67*
Dizplay 13 Page 68
Group set, Trip lire @ Page 68
MHessade e Page 68
Timer, Event action e 13 Page 69
[ata save o 13 Page 70
Savesload e b Page 70
Henu customize o b Page 70
*: Options
Basic setting mode menu
. . thernet
Basic Setting Hode
Setting menu
I — Page 71
/D, Hemory @ Page 71
Burnout, RIC e Page 71
Erwironment e b Page 71 and 72
Kewlock e 4 Page 72"
Login e 3 Page 737
Report b Page 73"
Time settingz @ Page 73
Load settings, Initialize Page 73
~ Communication (Ethernet} @p—————————————————————— Page 74to 76
Gommunication (Serialle—p————————— Page 77"
Status relay e Page 77
Page 77
*1: Options

*2: Displayed when the function is enabled in the Environment settings.
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Setup Items and Default Values

Date/Time > Date&Time

Setup Item Selectable Range or Selections Default Value Setting
Date&Time > Time set - -
Date/Time > Daylight Saving Time
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Start time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/ APR
OCT/NOV/DEC
Start time > Day order 1st/2nd/3rd/4th/Last 1st
Start time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Start time > Hour of the day Numerical value 2
End time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/ OCT
OCT/NOV/DEC
End time > Day order 1st/2nd/3rd/4th/Last Last
End time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
End time > Hour of the day Numerical value 1

Meas channel > Range, Alarm

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 1
Range > Mode Skip/Volt/TC/RTD/Scale/Delta/Dl/ Volt
1-5V/Sqrt
Mode=Volt
Range 20mV/60mV/200mV/2V/6V/20V/50V 2V
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Mode=TC
Range R/S/B/K/E/JIT/IN/W/L/U/WRe R
Span Lower Depends on the range. -
Span Upper Depends on the range. —
Mode=RTD
Range Pt/JPt Pt
Span Lower Depends on the range. -
Span Upper Depends on the range. —
Mode=Scale
Type Volt/TC/RTD/DI Volt
Range Depends on the type. -
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Scale Lower —30000 to 30000, decimal position: 0 to 4 0.00
Scale Upper —-30000 to 30000, decimal position: 0 to 4 200.00
Unit 6 characters or less
Mode=Delta
Type Volt/TC/RTD/DI Volt
Range Depends on the type. -
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Ref.CH Meas channel number - @
Mode=DI 2
Range Level/Cont Level 5:9 '§
Span Lower 0,1 0 "<' g
Span Upper 0,1 1 “c_’ :
23
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Setup Items and Default Values

Setup Item Selectable Range or Selections Default Value Setting
Mode=1-5V
Range 1-5V 1-5V
Span Lower 0.800 to 5.200 1.000
Span Upper 0.800 to 5.200 5.000
Scale Lower —30000 to 30000, decimal position :0 to 4 0.00
Scale Upper —30000 to 30000, decimal position :0 to 4 200.00
Unit 6 characters or less -
Low-cut On/Off Off
Mode=Sqrt
Range 20mV/60mV/200mV/2V/6V/20V/50V
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Scale Lower —30000 to 30000, decimal position: 0 to 4 0.00
Scale Upper —30000 to 30000, decimal position: 0 to 4 200.00
Unit 6 characters or less -
Low-cut On/Off Off
Low-cut value 0.0t0 5.0 0.5
Alarm
1,2,3,4 On/Off Off
Type H:High/L:Low/h:delta H/l:delta L/R:rate H/ H
rirate L/T:delayH/t:delayL
Value Numerical value -
Relay On/Off Off
Number 101/.../106 (Depends on the model.) 101
S01/S02/S03/.../S29/S30
Detect On/Off On
Meas channel > Tag, Memory, Delay
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 1
Tag > Characters 16 characters or less —
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10
Meas channel > Moving average
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 1
Moving average > On/Off On/Off Off
Moving average > Count 2 to 400 2
Meas channel > Color
Setup Item Selectable Range or Selections Default Value Setting
Group of channel 001-006, etc Depends on the model.
Color Red/Green/Blue/B.violet/Brown/Orange/ Red to Gray
Y.green/Lightblue/Violet/Graly/Lime/Cyan/
Darkblue/Yellow/Lightgray/Purple/Black/Pink/
L.brown/L.green/Darkgray/Olive/DarkCyan/
S.green (24 colors)
Meas channel > Zone, Scale
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 1
Zone > Lower 0to 95 0
Zone > Upper 5to 100 100
Scale > Position Off/1/2/3/4/5/6 1
Scale > Division 4/5/6/7/8/9/10/11/12/C10 10
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Setup Items and Default Values

Meas channel > Bar graph

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 1

Bar graph > Base position Normal/Center/Lower*/Upper* Normal

Bar graph > Division 4/5/6/7/8/9/10/11/12 10

* A function available on DXs with release number 2 or later.

Meas channel > Partial

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 1

On/Off On/Off Off

Expand 110 99% 50

Boundary Span Lower+1digit to Span Upper-1digit 0.0000

Meas channel > Alarm mark

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 1

Mark kind Alarm/Fixed Alarm

Indicate on Scale On/Off Off

Alarm mark color > Alarm 1 Red/Green/.../S.green (24 colors) Red

Alarm mark color > Alarm 2 Same as Alarm 1 Orange

Alarm mark color > Alarm 3 Same as Alarm 1 Orange

Alarm mark color > Alarm 4 Same as Alarm 1 Red

Meas channel > Color scale band

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 1

Band area Off/In/Out Off

Color Red/Green/.../S.green (24 colors) Lime

Display position > Lower Measuring range 0.0000

Display position > Upper Measuring range 0.0100

Meas channel > Calibration correction

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH

Channel number

1

Number of set points

Off/2/3/4/5/6/7/8/9/10/11/12/13/14/15/16

Off

1ton > MES val
1ton > True val

Value in the measuring range/measured value -

Measuring range
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Setup Items and Default Values

Math channel > Expression, Alarm

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
Math On/Off On/Off Off
Calculation expression 120 characters or less -
Span Lower —9999999 to 99999999, decimal position: 0 to 4 —200.00
Span Upper —9999999 to 99999999, decimal position: 0 to 4 200.00
Unit 6 characters or less —
Math alarm
1,2,3,4 On/Off Off
Type H:High/L:Low/T:delayH/t:delayL H
Value Numerical value -
Relay On/Off Off
No. 101/.../106 (Depends on the model.) 101
S01/S02/S03/.../S29/S30
Detect On/Off On
Math channel > Constant
Setup Item Selectable Range or Selections Default Value Setting
Number of constant K01 to K60 K01
Value —9.9999E+29 to —1.0000E-30, 0, 1
1.0000E—-30 to —9.9999E+29
Math channel > Tag, Memory, Delay
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
Tag > Tag 16 characters or less —
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10
Math channel > TLOG, Rolling average
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
TLOG > Timer No. 1/2/3/4 1
TLOG > Sum scale Off, /s, /Imin, /h Off
TLOG > Reset On/Off Off
Rolling average > On/Off On/Off Off
Rolling average > Interval 1s/2s/3s/4s/5s/6s/10s/12s/15s/20s/30s/ 10s
1min/2min/3min/4min/5min/6min/10min/12min/
15min/20min/30min/1h
Rolling average > Number of samples 1 to 1500 1
Math channel > Color
Setup Item Selectable Range or Selections Default Value Setting

Group of channel

101-106, etc

Depends on the model.

Color

Red/Green/.../S.green (24 colors)

Red to Gray

Math channel > Zone, Scale, Bar graph

Same as Meas channel.
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Setup Items and Default Values

Math channel > Partial

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101

On/Off On/Off Off

Expand 1to 99% 50

Boundary Span Lower+1digit to Span Upper—1digit  0.00

Math channel > Alarm mark

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101

Mark kind Alarm/Fixed Alarm

Indicate on Scale On/Off Off

Alarm mark color > Alarm 1 Red/Green/.../S.green (24 colors) Red

Alarm mark color > Alarm 2 Same as Alarm 1 Orange

Alarm mark color > Alarm 3 Same as Alarm 1 Orange

Alarm mark color > Alarm 4 Same as Alarm 1 Red

Math channel > Color scale band

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101

Band area Off/In/Out Off

Color Red/Green/.../S.green (24 colors) Lime

Display position > Lower Measuring range 0.00

Display position > Upper Measuring range 1.00

Math channel > Math start action

Setup Item Selectable Range or Selections Default Value Setting
Math start Off/Start/Rst+St Start
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Setup Items and Default Values

Display > Trend/Save interval

Setup Item Selectable Range or Selections Default Value Setting
Trend interval [/div] 15s/30s/1min/2min/5min/10min/15min/20min/ 1min
30min/1h/2h/4h/10h (Depends on the model.)
Save interval 10min to 31day (Depends on the trend interval.) 1h
Second interval [/div] 15s/30s/1min/2min/5min/10min/15min/20min/ 1min
30min/1h/2h/4h/10h (Depends on the model.)
Display > Trend
Setup Item Selectable Range or Selections Default Value Setting
Direction Horizontal/Vertical/Wide/Split Vertical
Trend clear On/Off Off
Message direction Horizontal/Vertical Horizontal
Scale > Digit Normal/Fine Normal
Scale > Value indicator Mark/Bargraph Mark
Trend line 1/2/3 2
Grid Auto/4/5/6/7/8/9/10/11/12 Auto
Display > Bar graph
Setup ltem Selectable Range or Selections Default Value Setting
Direction Horizontal/Vertical Vertical
Display > LCD
Setup Item Selectable Range or Selections Default Value Setting
Brightness 1/2/3/415/6/7/8 2
Backlight saver > Mode Off/Dimmer/Timeoff Off
Backlight saver > Saver time 1min/2min/5min/10min/30min/1h 1h
Backlight saver > Restore Key, Key+Alarm Key+Alarm
Display > Monitor
Setup Item Selectable Range or Selections Default Value Setting
Background > Display White/Black White
Background > Historical trend White/Cream/Black/Lightgray Black
Scroll time 5s/10s/20s/30s/1min 10s
Jump default display Off/1min/2min/5min/10min/20min/30min/1h Off
Group set, Trip line
Setup Item Selectable Range or Selections Default Value Setting
Group number 1/2/3/...19/10 1
Group set > On/Off On/Off Group 1to 4: On
Group 5 to 10: Off
Group set > Group name GROUP1 to GROUP10/16 characters or less GROUP1 etc.
Group set > CH set 39 characters or less Depends on the model.
Trip line
1,2,3,4 On/Off Off
Position 0to 100 50
Color Red/Green/.../S.green (24 colors) 1:Red, 2:Green
3:Blue, 4:Yellow
Width 1/2/3 2
Message
Setup Item Selectable Range or Selections Default Value Setting
Message No. 1-10/11-20/21-30/31-40/41-50/51-60/ 1-10
61-70/71-80/81-90/91-100
1to 100 32 characters or less —
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Setup Items and Default Values

Timer, Event action > Timer

Setup Item Selectable Range or Selections Default Value  Setting
Timer No. 1/2/3/4 1
Mode Off/Relative/Absolute Off
Relative > Interval 00:01 to 24:00 01:00
Relative > Reset at Math Start On/Off On
Absolute > Interval 1min/2min/3min/4min/5min/6min/10min/ 1h
12min/15min/20min/30min/1h/2h/3h/4h/
6h/8h/12h/24h
Absolute > Ref.time 0to 23 0:00
Timer, Event action > Match time timer
Setup Item Selectable Range or Selections Default Value  Setting
Timer number 1/2/3/4 1
Kind Off/Day/Week/Month Off
Day 1to 28 1
Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Hour 00:00 to 23:59 00:00
Timer action Single/Repeat Repeat
Timer, Event action > Event action
Setup Item Selectable Range or Selections Default Value  Setting
Logic box number 1/2/3/...139/40 1
Event None/Remote/Relay/Switch/Timer/ None
Matchtime/Alarm/UserKey
Remote > Remote number 1/2/3/415/6/7/8 1
Relay > Relay number 101/.../106 (Depends on the model.) 101
Switch > Switch No. S01/S02/S03/.../1S29/S30 S01

Timer > Timer No.

MatchTimeTimer > Match Time Timer No.

1/2/3/4
1/2/3/4

Action

Message > Message No.
Message > Write to

Message > Group number
Group > Group number

Flag > Flag number
TimerReset > Timer No.
PanelLoad > Setting file number

MemoryStart/Stop, MemoryStart, MemoryStop, Group
Trigger, AlarmACK, MathStart/Stop, MathStart,
MathStop, MathReset, SaveDisplay, SaveEvent,

Message, Snapshot, DisplayRate1/2,

ManualSample, TimerReset, DisplayGroupChange,

Flag, PanelLoad, TimeAdjust
1to 100

All/Select

1/2/3/...19110

1/2/3/...19/110

1/2/3/4/5/6/7/8

1/2/3/4

1/2/3
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Setup Items and Default Values

Data save > File header, File name

Setup Item Selectable Range or Selections Default Value Setting
File header > Characters 50 characters or less -
Data file name > Structure Date/Serial/Batch Date
Data file name > Identified strings 16 characters or less -
Data save > Save directory
Setup Item Selectable Range or Selections Default Value Setting
Directory name 20 characters or less DATAO
Data save > Event data
Setup Item Selectable Range or Selections Default Value Setting
Sample rate 25ms/125ms/250ms/500ms/1s/2s/5s/10s/ 1s
30s/60s/120s/300s/600s (Depends on the model.)
Mode Free/Single/Repeat Free
Data length 10min to 31day (Depends on the sample rate.) 1h
Pre-trigger 0/5/25/50/75/95/100 0
Trigger signal > Key On/Off On
Data save > Batch text
Setup Item Selectable Range or Selections Default Value Setting
Text field number 1/2/3/4/5/6/7/8 1
Text field > Title of field 20 characters or less -
Text field > Characters 30 characters or less -
Save/Load
Setup Item Selectable Range or Selections Default Value Setting
Load display data > Kind CF/USB CF
Load event data > Kind CF/USB CF
Load settings > Kind CF/USB CF
Save settings > Kind CF/USB CF
Save settings > File name 32 characters or less -
File list/delete > Kind CF/USB CF
Format > Kind CF/USB CF
Format > Volume name 11 characters or less -
Menu customize
Setup Item Selectable Range or Selections Default Value Setting

Function menu

Select/Hide/View/Transfer

Display menu

Separate/Select/Hide/View/Transfer
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Setup Items and Default Values

Alarm
Setup Item Selectable Range or Selections Default Value Setting
Basic setting
Reflash On/Off Off
Rate of change > Decrease 1to 32 1
Rate of change > Increase 1to 32 1
Indicator Hold/Nonhold Nonhold
Switch, Relay
Internal Switch > AND None/S01/S01-S02/.../S01-S29/S01-S30 None
Relay > AND None/I01/101-102/.../101-106 (Depends on the option.) None
Relay > Action Energize/De_energ Energize
Relay > Hold Hold/Nonehold Nonhold
Relay > Relay Action on ACK* Normal/Reset Normal
Hysteresis
Meas CH > High/Low 0.0t0 5.0 0.5
Meas CH > Delta High/Low 0.0t0 5.0 0.0
Math CH > High/Low 0.0 t0 5.0 0.0

* A function available on DXs with release number 2 or later.

A/D, Memory

Setup Item

Selectable Range or Selections

Default Value Setting

Scan interval > Scan mode

Normal/Fast

Normal

Normal > Scan interval 125ms/250ms (DX1002, DX1002N, DX1004, DX1004N) 125ms
1s/2s/5s (DX1006, DX1006N, DX1012, DX1012N) 1s
Normal > A/D integrate Auto/50Hz/60HZz/100ms Auto
Fast > Scan interval 25ms (DX1002, DX1002N, DX1004, DX1004N) 25ms
125ms (DX1006, DX1006N, DX1012, DX1012N) 125ms
Fast > A/D integrate 600Hz 600Hz
Memory > Data kind Display/E+D/Event Display

Burnout, RJC

Setup Item

Selectable Range or Selections

Default Value Setting

First-CH, Last-CH

Channel number

1

Burnout set > Mode Off/Up/Down Off
RJC > Mode Internal/External Internal
RJC > Volt —20000 to 20000uV 0

Environment > Operating environment

Setup Item Selectable Range or Selections Default Value Setting
Tag/Channel Tag/Channel Tag

Language English/Japanese/German/French/Chinese English

Remote Controller ID Off/0/1/.../130/31 Off

Temperature C/F C

Environment > View, Message, Input, Alarm

Setup Item Selectable Range or Selections Default Value Setting
View > Trend type T-Y TY

View > Partial On/Off Off

View > Trend rate switching On/Off Off

Message > Write group Common/Separate Common

Message > Power-fail message On/Off Off

Message > Change message On/Off Off

Input > Value on over-range Free/Over Over

Alarm > No logging On/Off Off
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Setup Items and Default Values

Environment > Security, Media save

Setup Item Selectable Range or Selections Default Value Setting
Security > Key Off/Login/Keylock Off

Security > Communication Off/Login Off

Save > Auto save On/Off On

Save > Media FIFO* On/Off Off

* A function available on DXs with release number 2 or later.

Environment > Batch

Setup ltem Selectable Range or Selections Default Value Setting
On/Off On/Off Off

Lot-No. digit Off/4/6/8 6

Auto increment On/Off On

Environment > Service port

Setup Item Selectable Range or Selections Default Value Setting
FTP 1 to 65535 21

HTTP 1 to 65535 80

SNTP 1 to 65535 123

Modbus 1 to 65535 502

Environment > Math

Setup Item Selectable Range or Selections Default Value Setting
Value on Error +Over/-Over +Over

Value on Overflow > SUM, AVE Error/Skip/Limit Skip

Value on Overflow > MAX, MIN, P-P Over/Skip Over

Environment > Report

Setup Item Selectable Range or Selections Default Value Setting
Report select > 1 Max/Min/Ave/Sum/Inst Ave

Report select > 2 Off/Max/Min/Ave/Sum/Inst Max

Report select > 3 Off/Max/Min/Ave/Sum/Inst Min

Report select > 4 Off/Max/Min/Ave/Sum/Inst Sum

File type Separate/Combine Separate

Keylock > Password, Key action, Media

Setup Item Selectable Range or Selections Default Value Setting
Password 8 characters or less —

Key action > START Free/Lock Free

Key action > STOP Free/Lock Free

Key action > MENU Free/Lock Free

Key action > USER Free/Lock Free

Key action > DISP/ENTER Free/Lock Free

Key action > FAVORITE Free/Lock Free

External media Free/Lock Free

Keylock > Action of Function

Setup Item Selectable Range or Selections Default Value Setting

Action of Function > AlarmACK
Action of Function > Message/Batch
Action of Function > Math

Action of Function > Data save
Action of Function > E-mail/FTP
Action of Function > Time set

Action of Function > Display Function

Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock

Free
Free
Free
Free
Free
Free
Free
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Setup Items and Default Values

Login > Basic settings

Setup Item Selectable Range or Selections Default Value  Setting
User basic settings > Auto logout Off/1min/2min/5min/10min Off
User basic settings > Operation without Login ~ Off/Display Off
Login > Admin settings
Setup Item Selectable Range or Selections Default Value  Setting
Admin number 1/12/3/4/5 1
Mode Off/Key/Comm/Web/Key+Comm Off
User name 20 characters or less Admin1 etc.
Password 8 characters or less 2?2°?77?°7°7?
Login > User settings
Setup Item Selectable Range or Selections Default Value  Setting
User number 1/2/3/...129/30 1
Mode Off/Key/Comm/Web/Key+Comm Off
User name 20 characters or less User1 etc.
Password 8 characters or less 2?2?07
Authority of user Off/1/2/3/4/5/6/7/8/9/10 Off
Login > Authority of user
Setup Item Selectable Range or Selections Default Value  Setting
Key action, Media
Authority of user 1/2/3/415/6/7/8/9/10 1
Key action > START Free/Lock Free
Key action > STOP Free/Lock Free
Key action > MENU Free/Lock Free
Key action > USER Free/Lock Free
Key action > DISP/ENTER Free/Lock Free
Key action > FAVORITE Free/Lock Free
External media Free/Lock Free
Action of Function
Authority of user 1/2/3/4/5/6/7/8/9/10 1
Action of Function > AlarmACK Free/Lock Free
Action of Function > Message/Batch Free/Lock Free
Action of Function > Math Free/Lock Free
Action of Function > Data save Free/Lock Free
Action of Function > E-mail/FTP Free/Lock Free
Action of Function > Time set Free/Lock Free
Action of Function > Display Function Free/Lock Free
Report
Setup Item Selectable Range or Selections Default Value Setting
Basic settings > Report kind Off/Hour/Day/Hour+Day/Day+Week/Day+Month  Off
Basic settings > Date 1to 28 1
Basic settings > Day of the week (Day+week) SUN/MON/TUE/WED/THU/FRI/SAT SUN
Basic settings > Time (hour) 0to 23 0:00
Report settings > Report channel number R01/R02/R03/.../R23/R24 RO1
Report settings > On/Off On/Off Depends on
the model
Report settings > Channel Channel number 1 etc.
Report settings > Sum scale Off, /s, /Imin, /h, /day /s
Time settings
Setup Item Selectable Range or Selections Default Value Setting
Time zone (HHMM) —1300 to 1300 900
Time deviation limit Off/10s/20s/30s/1min/2min/3min/4min/5min 30s
Date format Y/M/D, M/D/Y, DIM/Y, D.M.Y Y/M/D
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Setup Items and Default Values

Load settings, Initialize

Setup Item Selectable Range or Selections Default Value Setting
Load settings > Kind CF/USB CF
Initialize > Kind Clear 1/Clear 2/Clear 3 Clear 3
Media eject CF/USB -
Communication (Ethernet) > IP-address
Setup Item Selectable Range or Selections Default Value Setting
DHCP Use/Not Not
DNS accession Use/Not Use
Host-name register Use/Not Use
Fixed IP-address > IP-address 0.0.0.0 to 255.255.255.255 0.0.0.0
Fixed IP-address > Subnet mask 0.0.0.0 to 255.255.255.255 0.0.0.0
Fixed IP-address > Default gateway 0.0.0.0 to 255.255.255.255 0.0.0.0
Communication (Ethernet) > Host settings
Setup Item Selectable Range or Selections Default Value Setting
Host name 64 characters or less —
Domain name 64 characters or less —
Communication (Ethernet) > DNS settings
Setup Item Selectable Range or Selections Default Value Setting
Server search order > Primary 0.0.0.0 to 255.255.255.255 0.0.0.0
Server search order > Secondary 0.0.0.0 to 255.255.255.255 0.0.0.0
Domain suffix search order > Primary 64 characters or less -
Domain suffix search order > Secondary 64 characters or less —
Communication (Ethernet) > Keep alive, Timeout
Setup ltem Selectable Range or Selections Default Value Setting
Keep alive On/Off On
Application time out > On/Off On/Off Off
Application time out > Time 1to 120 (min) 1
Communication(Ethernet) > Server
Setup Item Selectable Range or Selections Default Value Setting
FTP Use/Not Not
Web Use/Not Use*
SNTP Use/Not Not
Modbus Use/Not Not
* Avalue on DXs with release number 2 or later.
Communication (Ethernet) > Web page
Setup Item Selectable Range or Selections Default Value Setting
Page type Operator/Monitor Operator
Page type=Operator
On/Off On/Off Off
Access control Off/Admin Off
Command Use/Not Not
Page type=Monitor
On/Off On/Off Off
Access control Off/Admin/User Off

74

IM 04L41B01-02E



Setup Items and Default Values

Communication (Ethernet) > E-Mail

Setup Item

Selectable Range or Selections

Default Value Setting

Basic settings
SMTP server name

64 characters or less

Port number 0 to 65535 25
Recipient 1 150 characters or less -
Recipient 2 150 characters or less -
Sender 64 characters or less -
Alarm settings
Recipient 1 On/Off Off
Recipient 2 On/Off Off
Active Alarms > Alarm 1 On/Off Off
Active Alarms > Alarm 2 On/Off Off
Active Alarms > Alarm 3 On/Off Off
Active Alarms > Alarm 4 On/Off Off
Include INST On/Off Off
Include source URL On/Off Off
Subject 32 characters or less Alarm_summary
Header 1 64 characters or less -
Header 2 64 characters or less -
Scheduled settings
Recipient 1 On/Off Off
Interval 1h/2h/3h/4h/6h/8h/12h/24h 24h
Ref.time 00:00 to 23:59 00:00
Recipient 2 On/Off Off
Interval 1h/2h/3h/4h/6h/8h/12h/24h 24h
Ref.time 00:00 to 23:59 00:00
Include INST On/Off Off
Include source URL On/Off Off
Subject 32 characters or less Periodic_data
Header 1 64 characters or less -
Header 2 64 characters or less —
System settings
Recipient 1 On/Off Off
Recipient 2 On/Off Off
Include source URL On/Off Off
Subject 32 characters or less System_warning
Header 1 64 characters or less -
Header 2 64 characters or less -
Report settings
Recipient 1 On/Off Off
Recipient 2 On/Off Off
Include source URL On/Off Off
Subject 32 characters or less Report_data
Header 1 64 characters or less -
Header 2 64 characters or less -
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Setup Items and Default Values

Communication (Ethernet) > FTP client

Setup ltem Selectable Range or Selections Default Value Setting
FTP transfer file
Disp&Event data On/Off Off
Report On/Off Off
Snapshot On/Off Off
FTP connection Primary/Secondary Primary
FTP server name 64 characters or less -
Port number 0 to 65535 21
Login name 32 characters or less -
Password 32 characters or less -
Account 32 characters or less -
PASV mode On/Off Off
Initial path 64 characters or less —
Communication (Ethernet) > SNTP client
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Server name 64 characters or less -
Port number 0 to 65535 123
Access interval Off/1h/8h/12h/24h 8h
Access reference time 00:00 to 23:59 00:00
Access timeout 10s/30s/90s 30s
Time adjust on Start action On/Off Off
Communication (Ethernet) > Modbus client
Setup Item Selectable Range or Selections Default Value Setting
Basic settings
Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s
Retry interval Off/10s/20s/30s/1min/2min/5min/10min/ 2min
20min/30min/1h
Modbus server settings
Server number 1-8/9-16 1-8
Port 0 to 65535 502
Modbus server name 64 characters or less -
Unit Auto/Fixed Auto
No. 0 to 255 1
Command settings
Client command number 1-8/9-16 1-8
1to 16 Off/R/IR-M/W/W-M Off
First Depends on the command type. -
Last Depends on the command type. -
Server 1/2/3/...115/16 1
Regi. Numerical value 30001
Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16

UINT32_L/FLOAT_B/FLOAT_L
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Setup Items and Default Values

Communication (Serial)

Setup Item Selectable Range or Selections Default Value Setting
Basic settings
Baud rate 1200/2400/4800/9600/19200/38400 9600
Data length 7/8 8
Parity Odd/Even/None Even
Handshaking Off:Off XON:XON/XON:RS/CS:RS Off:Off
Address 110 99 1
Protocol Normal/Modbus/Modbus-M Normal
Modbus master > Basic settings
Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s
Timeout 125ms/250ms/500ms/1s/2s/5s/10s/1min 1s
Retrials Off/1/2/3/4/5/10/20 1
Inter-block delay Off/5ms/10ms/15ms/45ms/100ms Off
Auto recovery Off/1min/2min/5min/10min/20min/30min/1h 2min
Modbus master > Command settings
Master command number 1-8/9-16 1-8
1t0 16 Off/IR/R-M/W/W-M Off
First Depends on the command type. -
Last Depends on the command type. -
Addr. 1to0 247 1
Regi. Numerical value 30001
Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16
UINT32_L/FLOAT_B/FLOAT_L
Status relay
Setup Item Selectable Range or Selections Default Value Setting
Memory/Media status On/Off Off
Measurement error On/Off Off
Communication error On/Off Off
Memory stop On/Off Off
End
Setup Item Selectable Range or Selections Default Value Setting

Do you want to store and
make the new settings take effect?

Yes/No/Cancel
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